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Chapter 1. Preparing to Install
Installing IBM® products is a multi-step process that involves working with a
number of software and hardware elements that are not provided by IBM . While
the IBM documentation provides some guidance regarding specific configurations
and procedures required to install IBM products, for details on working with these
systems that are not provided by IBM , consult those products' documentation.
Before you begin to install the IBM EMM software, plan your installation,
including both your business objectives and the hardware and software
environment required to support them.

Marketing Platform basic installation checklist
Read this chapter to gain an overview of the installation process and verify that
your environment, planned order of installation, and knowledge levels fulfill the
prerequisites.
The following list is a high-level overview of the steps required to perform a basic
installation of the Marketing Platform. Additional details about these steps are
provided in the rest of this guide.
Prepare the Marketing Platform data source
1. “Step: Create the Marketing Platform system table database or schema” on
page 5
Create the Marketing Platform system table database or schema and record the
information.
2. “Step: Configure the web application server for your JDBC driver” on page 6
Add the database driver for the Marketing Platform system table database to
the web application server classpath.
3. “Step: Create the JDBC connection in the web application server” on page 6
Create a JDBC connection to the Marketing Platform system table database. Be
sure to use UnicaPlatformDS as the JNDI name for the connection.
Install the Marketing Platform
1. Chapter 3, “Installing the IBM Marketing Platform,” on page 9
Download the IBM and Marketing Platform installers.
2. “Step: Obtain required information” on page 16
Gather the required database and web application server information.
3. “Step: Run the IBM installer” on page 17
The IBM installer launches installers for all products it finds in the same
directory.
4. “Step: Create and populate the Marketing Platform system tables manually, if
necessary” on page 18
If your company policy does not permit the installer to create the Marketing
Platform system tables automatically, or if automatic creation did not occur due
to a connection failure, create the tables manually.
Deploy the Marketing Platform
© IBM Corporation 1999, 2012
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1. Chapter 4, “Deploying the IBM Marketing Platform,” on page 21
Follow the specific guidelines for WebSphere® or WebLogic.
2. “Step: Verify your Marketing Platform installation” on page 23
Log in to IBM EMM and check basic functions.
Configure the Marketing Platform
1. Chapter 5, “Configuring the IBM Marketing Platform After Deployment,” on
page 25
Set password constraints or configure the Java™ Message Service for optimum
performance of the Scheduler, or install reporting.
2. Chapter 8, “Installing Reports,” on page 47
If you plan to use the reporting feature in any of the IBM Enterprise products,
see the Reporting chapter.

IBM components and where to install them
The following diagram provides a brief overview of where to install IBM
applications.
This setup is the basic installation that functions. You might require a more
complex, distributed installation to meet your security and performance
requirements.

Prerequisites
The following are prerequisites for installing IBM EMM products.

System requirements
For detailed system requirements, see the IBM EMM Enterprise Products
Recommended Software Environments and Minimum System Requirements guide.

JVM requirement
IBM EMM applications within a suite must be deployed on a dedicated Java
Virtual Machine (JVM). IBM EMM products customize the JVM used by the web
application server. You might need to create an Oracle WebLogic or WebSphere
domain dedicated to IBM EMM products if you encounter JVM-related errors.

2
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Network domain requirement
IBM EMM products that are installed as a Suite must be installed on the same
network domain, to comply with browser restrictions designed to limit cross-site
scripting security risks.

Knowledge requirement
To install IBM EMM products, you must possess or work with people who possess
a thorough knowledge of the environment in which the products are installed. This
knowledge includes the operating systems, databases, and web application servers.

Required permissions
Verify that your network permissions allow you to perform the procedures in this
guide, that you have logins with appropriate permissions, and that the product
installation files that you download have appropriate permissions, as follows.
v You must have the administrative login name and password for your web
application server.
v You must have administration access for all necessary databases.
v You must have write permission for all files that you must edit.
v You must have write permission for all directories where you must save a file,
such as the installation directory and backup directory if you are upgrading.
v The operating system account that you use to run the web application server
and IBM EMM components must have read and write access to the relevant
directory and subdirectories.
v You must have appropriate read/write/execute permissions to run the installer.
On UNIX, the user account that performs the IBM product installation must be a
member of the same group as the user account that installed the web application
server on which it will be deployed. This is because the web application server
needs access to the product's file system.
v On UNIX, all of the installer files for IBM products must have full execute
permissions (rwxr-xr-x).

If you are upgrading or installing in a cluster
If you are upgrading, you should read Chapter 7, “Upgrading the IBM Marketing
Platform,” on page 29.
If you are installing the Marketing Platform in a cluster, you should read
Chapter 6, “Installing the IBM Marketing Platform in a Cluster,” on page 27.

Chapter 1. Preparing to Install
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Chapter 2. Preparing the IBM Marketing Platform Data Source
This section provides the information you need to set up the database and JDBC
connection for the Marketing Platform system tables. You will enter the details
about this database when you run the IBM installer later in the installation process,
so you should print and fill in the “Marketing Platform database information
checklist” on page 8.

Step: Create the Marketing Platform system table database or schema
1. Work with a database administrator to create the Marketing Platform system
table database or schema.
Follow these vendor-specific guidelines.
v If your Marketing Platform system tables are in Oracle, you must enable auto
commit for the environment open. See the Oracle documentation for
instructions.
v If your Marketing Platform system tables are in DB2®, set the database page
size to at least 16k (32k if you need to support Unicode). See the DB2
documentation for instructions.
v If Marketing Platform system tables are in SQL Server, you must use either
SQL Server authentication only, or both SQL Server and Windows
authentication, because the Marketing Platform requires SQL Server
authentication. If necessary, change the database configuration so that your
database authentication includes SQL Server. Also be sure that TCP/IP is
enabled in your SQL Server.
If you plan to enable locales that use multi-byte characters (for example,
Chinese, Korean, and Japanese), ensure that the database is created to support
them.
2. Have the database administrator create an account that can be used to create
and populate the Marketing Platform system tables. This is done later in the
installation process, and can be performed manually or automatically by the
IBM EMM installer
This account must have at least the following rights.
v
v
v
v
v

CREATE TABLES
CREATE VIEWS (for reporting)
CREATE SEQUENCE (Oracle only)
CREATE INDICES
ALTER TABLE

v INSERT
v UPDATE
v DELETE
3. Obtain the information about your database or schema and the database
account and then print and complete the “Marketing Platform database
information checklist” on page 8. You will need this information during later
steps in the installation process.

© IBM Corporation 1999, 2012
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Step: Configure the web application server for your JDBC driver
You must obtain the correct JAR file for the JDBC connections the Marketing
Platform requires. You must also add the location of the file to the classpath of the
web application server where you plan to deploy the Marketing Platform.
1. Obtain the latest vendor-provided Type 4 JDBC driver supported by IBM EMM,
as described the the Recommended Software Environments and Minimum System
Requirements document.
v If the driver does not exist on the machine where the Marketing Platform
will be deployed, obtain it and unpack it on the machine where you plan to
deploy the Marketing Platform. Unpack the drivers in a path that does not
include spaces.
v If you obtain the driver from a machine where the data source client is
installed, verify that the version is the latest supported by IBM .
See the Recommended Software Environments and Minimum System Requirements
document for supported drivers.
2. Include the full path to the driver, including the file name, in the classpath of
the web application server where you plan to deploy the Marketing Platform,
as follows.
v For all supported versions of WebLogic, set the classpath in the
setDomainEnv script in the WebLogic_domain_directory/bin directory where
environment variables are configured. Your driver entry must be the first
entry in the CLASSPATH list of values, before any existing values, to ensure
that the web application server uses the correct driver. For example:
UNIX
CLASSPATH="/home/oracle/product/10.2.0/jdbc/lib/ojdbc14.jar:
${PRE_CLASSPATH}${CLASSPATHSEP}${WEBLOGIC_CLASSPATH}
${CLASSPATHSEP}${POST_CLASSPATH}${CLASSPATHSEP}${WLP_POST_CLASSPATH}"
export CLASSPATH

Windows
set CLASSPATH=c:\oracle\jdbc\lib\ojdbc14.jar;%PRE_CLASSPATH%;
%WEBLOGIC_CLASSPATH%;%POST_CLASSPATH%;%WLP_POST_CLASSPATH%

v For all supported versions of WebSphere, you set the classpath in the next
step, while you are setting up the JDBC providers for the Marketing
Platform.
3. Make a note of this database driver classpath in the Marketing Platform
database information checklist, as you will need to enter it when you run the
installer.
4. Restart the web application server so your changes take effect.
During startup, monitor the console log to confirm that the classpath contains
the path to the database driver.

Step: Create the JDBC connection in the web application server
The Marketing Platform web application must be able to communicate with its
system table database using a JDBC connection. You must create this JDBC
connection in the web application server where you plan to deploy the Marketing
Platform.
In WebSphere, set the classpath for your database driver during this process.
Important: You must use UnicaPlatformDS as the JNDI name. This is required, and
is noted in the “Marketing Platform database information checklist” on page 8.
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Note: When the Marketing Platform system tables are created in a different
schema from the default schema of the database login user, you must specify that
non-default schema name in the JDBC connection used to access the system tables.

Information for JDBC connections
When you create a JDBC connection, you can use this section to help you
determine some of the values you must enter. If you are not using the default port
setting for your database, change it to the correct value.
This information does not exactly reflect all of the information required by the web
application servers. Where this section does not provide explicit instructions, you
can accept the default values. Consult the application server documentation if you
need more comprehensive help.

WebLogic
Use these values if your application server is WebLogic.
SQLServer
v Driver: Microsoft MS SQL Server Driver (Type 4) Versions: 2008, 2008R2
v Default port: 1433
v Driver class: com.microsoft.sqlserver.jdbc.SQLServerDriver
v Driver URL: jdbc:sqlserver://
<your_db_host>:<your_db_port>;databaseName=<your_db_name>
v Properties: Add user=<your_db_user_name>
Oracle 11 and 11g
v Driver: Other
v Default port: 1521
v Driver class: oracle.jdbc.OracleDriver
v Driver URL:
jdbc:oracle:thin:@<your_db_host>:<your_db_port>:<your_db_service_name>
v Properties: Add user=<your_db_user_name>
DB2
v Driver: Other
v Default port: 50000
v Driver class: com.ibm.db2.jcc.DB2Driver
v Driver URL: jdbc:db2://<your_db_host>:<your_db_port>/<your_db_name>
v Properties: Add user=<your_db_user_name>

WebSphere
Use these values if your application server is WebSphere.
SQLServer
v Driver: N/A
v Default port: 1433
v Driver class: com.microsoft.sqlserver.jdbc.SQLServerConnectionPoolDataSource
v Driver URL: N/A
Chapter 2. Preparing the IBM Marketing Platform Data Source

7

In the Database Type field, select User-defined.
After you create the JDBC Provider and Data Source, go to the Custom Properties
for the Data Source, and add and modify properties as follows.
v serverName=<your_SQL_server_name>
v portNumber =<SQL_Server_Port_Number>
v databaseName=<your_database_name>
v

enable2Phase = false

Oracle 11 and 11g
v Driver: Oracle JDBC Driver
v Default port: 1521
v Driver class: oracle.jdbc.OracleDriver
v Driver URL:
jdbc:oracle:thin:@<your_db_host>:<your_db_port>:<your_db_service_name>
DB2
v
v
v
v

Driver: DB2 Universal JDBC Driver Provider
Default port: 50000
Driver class: com.ibm.db2.jcc.DB2Driver
Driver URL: jdbc:db2://<your_db_host>:<your_db_port>/<your_db_name>

Marketing Platform database information checklist
Type

Name

Data source type
Data source name
Data source host name
Data source port
Data source account user name
Data source account password
JNDI name
JDBC driver class
JDBC connection URL
JDBC driver classpath on your system

8
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UnicaPlatformDS

Chapter 3. Installing the IBM Marketing Platform
Obtain the DVD, or download the software from IBM .
Important: Place all of the installation files in the same directory. This is an
installation requirement.
To install the Marketing Platform you need the following.
v The IBM master installer
v The Marketing Platform installer

Setting permissions on UNIX-type systems
On UNIX-type systems, ensure that the installation files have full execute
permissions (rwxr-xr-x).

Choosing the right installer file
The IBM EMM installation files are named according to the version of the product
and the operating system with which they are meant to be used, except for UNIX
installers intended to be run in console mode, which are not operating
system-specific. For UNIX, different installers are used depending on whether the
installation mode is X-windows or console.
Here are some examples of the installers you would choose based on your
installation environment.
If you plan to install on Windows using either GUI or console mode —
Product_N.N.N.N_win.exe is version N.N.N.N and is intended for installation on the
Windows operating systems.
If you plan to install on Solaris using X-windows mode —
Product_N.N.N.N_solaris.bin is version N.N.N.N and is intended for installation on
the Solaris operating system.
If you plan to install on a UNIX type system using console mode —
Product_N.N.N.N_.sh is version N.N.N.N and is intended for installation on all
supported UNIX type operating systems.

How the IBM EMM installers work
You should read this section if you are not familiar with the basic functions of the
IBM EMM installers.

Single directory requirement for installer files
When you install IBM enterprise products, you use a combination of installers.
v A master installer, which has Unica_Installer in the file name
v Product-specific installers, which all have the product name as part of their file
names

© Copyright IBM Corp. 1999, 2012

9

To install IBM EMM products, you must place the master installer and the product
installers in the same directory. When you run the master installer, it detects the
product installation files in the directory. You can then select the products you
want to install.
When multiple versions of a product installer are present in the directory with the
master installer, the master installer always shows the latest version of the product
on the IBM Products screen in the installation wizard.

Installing patches
You might be planning to install a patch immediately after you perform a new
installation of an IBM product. If so, place the patch installer in the directory with
the base version and master installer. When you run the installer, you can select
both the base version and the patch. The installer then installs both in correct
order.

Check for a JAVA_HOME environment variable
If you have a JAVA_HOME environment variable defined on the machine where you
are installing an IBM EMM product, verify that it is pointing to version 1.6 of the
Sun JRE.
This environment variable is not required for installing IBM EMM products, but if
it is present, it must point to the 1.6 version of the Sun JRE.
If you have a JAVA_HOME environment variable, and it points to an incorrect JRE,
you must unset the JAVA_HOME variable before you run the IBM EMM installers.
You can do this as follows.
v Windows: In a command window, enter
set JAVA_HOME=leave empty and press return key
v UNIX-type systems: In the terminal, enter
export JAVA_HOME=leave empty and press return key
After the environment variable is unset, the IBM EMM installers use the JRE
bundled with the installers.
You can reset the environment variable when installation is complete.

Choosing product installation directories
You can install to any directory on any network-accessible system. You can specify
an installation directory by entering a path or by browsing and selecting it.
You can specify a path relative to the directory from which you are running the
installer by typing a period before the path.
If the directory you specify does not exist, the installer creates it, assuming that the
user performing the installation has appropriate permissions.
The default top-level directory for IBM installations is named IBM/Unica. The
product installers then install in subdirectories under the Unica directory.

Installation types
The IBM EMM installer performs the following types of installation.

10
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v New installation: When you run the installer and select a directory where an
IBM EMM product has never been installed, the installer automatically performs
a new installation.
v Upgrade installation: When you run the installer and select a directory where an
earlier version of an IBM EMM product is installed, the installer automatically
performs an upgrade installation. For products where installers automatically
update the database, upgrade installation adds new tables but does not
overwrite data in existing tables.
For products where installers automatically update the database, errors can
occur during an upgrade because the installer does not create tables in the
database if they exist. You can safely ignore these errors. See the chapter on
Upgrading for details.
v Reinstallation: When you run the installer and select a directory where the same
version of an IBM EMM product is installed, the installer overwrites your
existing installation. To preserve any existing data, back up your installation
directories and your system table databases before reinstalling.
Typically, reinstallation is not recommended.

Installation modes
The IBM EMM installer can run in the following modes.
v Console (command line) mode
In console mode, options are presented in numbered lists. You supply a number
to select the option you want. If you press Enter without entering a number, the
installer uses the default option. The default option is indicated by one of the
following symbols.
--> To select an option when this symbol appears, type the number of the
option you want then press Enter.
[X] This symbol indicates that you can choose one, several, or all of the options
in the list. If you type the number of an option that has the [X] symbol next to it
then press Enter, you clear or deselect that option. If you type the number of an
option that is not currently selected (it has [ ] next to it), that option is selected
when you press Enter.
To deselect or select more than one option, enter a comma-separated list of
numbers.
v Windows GUI or UNIX X-windows mode
v Unattended, or silent, mode, which allows no user interaction
Unattended mode can be used to install an IBM EMM product multiple times,
for example when you set up a clustered environment. For more information,
see “Installing multiple times using unattended mode.”

Installing multiple times using unattended mode
If you must install IBM EMM products multiple times, for example when setting
up a clustered environment, you may want to run the IBM installer in unattended
mode, which requires no user input.

About the response files
Unattended mode (also known as silent mode) requires a file or set of files to
provide the information that a user would enter at the installation prompts when
using the console or GUI modes. These files are known as response files.
You can use either of these options to create response files.
Chapter 3. Installing the IBM Marketing Platform
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v You can use the sample response file as a template for directly creating your
response files. The sample files are included with your product installers in a
compressed archive named ResponseFiles. The response files are named as
follows.
– IBM installer - installer.properties
– Product installer - installer_ followed by initials for the product name. For
example, the Campaign installer has a response file named
installer_uc.properties.
– Product reports packs installer - installer_ followed by initials for the
product name plus rp. For example, the Campaign reports pack installer has a
response file named installer_urpc.properties.
Edit the sample files as needed and place them in the same directory with your
installers.
v Before you set up an unattended run, you can run the installer in Windows GUI
or UNIX X-windows mode or in Console mode and choose to create the
response files.
The IBM master installer creates one file, and each IBM product you install also
creates one or more files.
The response files have .properties extensions, such as
installer_product.properties and the file for the IBM installer itself, which is
named installer.properties. The installer creates these files in the directory
you indicate.
Important: For security reasons, the installer does not record database
passwords in the response files. When you create response files for unattended
mode, you must edit each response file to enter database passwords. Open each
response file and search for PASSWORD to find where you must perform these
edits.

Where the installer looks for response files
When the installer runs in unattended mode, it looks for the response file as
follows.
v First, the installer looks in the installation directory.
v Next, the installer looks in the home directory of the user performing the
installation.
All response files must be in the same directory. You can change the path where
response files are read by adding arguments to the command line. For example:
-DUNICA_REPLAY_READ_DIR="myDirPath" -f myDirPath/installer.properties

Effect of unattended mode when you uninstall
When you uninstall a product that was installed using unattended mode, the
uninstall is performed in unattended mode (without presenting any dialogs for
user interaction).

Unattended mode and upgrades
When you are upgrading, if a response file was previously created and you run in
unattended mode, the installer uses the installation directory that was previously
set. If you want to upgrade using unattended mode when no response file exists,
create a response file by running the installer manually for your first installation,
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and be sure to select your current installation directory in the installation wizard.

Automatic vs. manual system table creation
The Marketing Platform installer lets you choose whether or not to allow the
installer to create the system tables in the database.
If you choose to allow the installer to create the system tables, you must provide
information that enables the installer to connect to the Marketing Platform
database you created in an earlier step. For the Marketing Platform, this is the
same information that you provide in the IBM master installer for product
registration, as described in “Step: Obtain required information” on page 16.
If you choose to create the system tables manually, you must use your database
client to run the SQL scripts provided with your Marketing Platform installation.
Details for manual table creation are provided in “Step: Create and populate the
Marketing Platform system tables manually, if necessary” on page 18.

Creating EAR files for clustered deployments
IBM supports clustering. The supported web application servers allow you to
deploy and manage deployments from a single administration console. To take
advantage of these features, you must use EAR files for deployments.
The master installer can create one or more EAR files containing the installed
products that you specify. You then deploy the EAR file or files that include the
products.
If you deploy more than one EAR file in a domain, the name you give the EAR file
must be unique within that domain.
You can use the IBM installer to create a new EAR file of your installed products at
any time after your initial installation. See “To create an EAR file after running the
installer.”
Note the following details about specific products.
v eMessage, Contact Optimization, and Interact Design Time do not include a
WAR file to be deployed on a web application server, so they are not available
for inclusion in an EAR file. Interact Run Time does have a WAR file and
therefore can be included in an EAR file.

To create an EAR file after running the installer
Use this procedure if you want to create an EAR file after you have installed IBM
EMM products. You might want to do this if you decide you want a different
combination of products in the EAR file.
The WAR files must be in a single directory. You will run the installer in console
mode, from the command line.
1. If this is the first time you are running the installer in console mode, make a
backup copy of the installer's .properties file for each of your installed
products.
Each IBM product installer creates one or more response files with a
.properties extension. These files are located in the same directory where you
have placed the installers. Be sure to back up all files with the .properties
extension, including the installer_product.properties files and the file for the
IBM installer itself, which is named installer.properties.
Chapter 3. Installing the IBM Marketing Platform
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If you plan to run the installer in unattended mode, you should back up the
original .properties files, because when the installer runs in unattended mode,
it clears these files. To create an EAR file, you need the information that the
installer writes in the .properties files during the initial install.
2. Open a command window and change directories to the directory that contains
the installer.
3. Run the installer executable with this option:
-DUNICA_GOTO_CREATEEARFILE=TRUE
On UNIX-type systems, run the .bin file rather than the .sh file.
The installer wizard runs.
4. Follow the instructions in the wizard.
5. Before you create additional EAR files, overwrite the .properties file or files
with the backup(s) you created before you ran in console mode for the first
time.

IBM Site ID
The installer might prompt you to enter your IBM Site ID. Your IBM Site ID can be
found on the IBM Welcome letter, Tech Support Welcome letter, Proof of
Entitlement letter, or other communications sent when you purchased your
software.
IBM might use data provided by the software to better understand how customers
use our products and to improve customer support. The data gathered does not
include any information that identifies individuals.
If you do not want to have such information collected, after the Marketing
Platform is installed, log on to the Marketing Platform as a user with
administration privileges. Navigate to the Settings > Configuration page, and set
the Disable Page Tagging property under the Platform category to True.

IBM EMM installer exit codes
This section describes standard exit codes produced by the IBM EMM installer.
The codes are listed with the Windows code first, followed by the equivalent code
in Linux, in parentheses.
If you see a value other than 0 or 1, it means the installation failed for one of the
reasons cited below.
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Code

Description

0 (0)

Success: The installation completed successfully without any
warnings or errors.

1 (1)

The installation completed successfully, but one or more of the
actions from the installation sequence caused a warning or a
non-fatal error.

-1 (255)

Canceled by the user.

1000 (232)

The installation includes an invalid command-line option.

1001 (233)

One or more of the actions from the installation sequence caused an
unrecoverable error.

2000 (208)

Unhandled error
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Code

Description

2001 (209)

The installation failed the authorization check, may indicate an
expired version.

2002 (210)

The installation failed a rules check. A rule placed on the installer
itself failed.

2003 (211)

An unresolved dependency in silent mode caused the installer to
exit.

2004 (212)

The installation failed because not enough disk space was detected
during the execution of the Install action.

2005 (213)

The installation failed while trying to install on a Windows 64-bit
system, but installation did not include support for Windows 64-bit
systems.

2006 (214)

The installation failed because it was launched in a UI mode that is
not supported by this installer.

3000 (184)

Unhandled error specific to a launcher.

3001 (185)

The installation failed due to an error specific to the lax.main.class
property.

3002 (186)

The installation failed due to an error specific to the
lax.main.method property.

3003 (187)

The installation was unable to access the method specified in the
lax.main.method property.

3004 (188)

The installation failed due to an exception error caused by the
lax.main.method property.

3005 (189)

The installation failed because no value was assigned to the
lax.application.name property.

3006 (190)

The installation was unable to access the value assigned to the
lax.nl.java.launcher.main.class property.

3007 (191)

The installation failed due to an error specific to the
lax.nl.java.launcher.main.class property.

3008 (192)

The installation failed due to an error specific to the
lax.nl.java.launcher.main.method property.

3009 (193)

The installation was unable to access the method specified in the
lax.nl.launcher.java.main.method property.

4000 (160)

A Java executable could not be found at the directory specified by
the java.home system property.

4001 (161)

An incorrect path to the installer jar caused the relauncher to
launch incorrectly.

5000 (136)

Modification of existing instance failed because the instance has not
been uninstalled properly or because the Registry has been
corrupted.

Where to install Marketing Platform components
The Marketing Platform application contains the IBM common navigation,
reporting, user administration, security, scheduling, and configuration management
features. Follow these guidelines.
v For each IBM EMM environment, you must install and deploy the Marketing
Platform once.
v If you want to use the Marketing Platform utilities on additional machines, you
must install both the utilities and the web application. This is needed because
Chapter 3. Installing the IBM Marketing Platform
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the utilities use the jar files in the web application. However, when you install
the Marketing Platform for this purpose, you do not have to deploy the
Marketing Platform again, nor do you have to create additional Marketing
Platform system tables.
The following table describes the components you can select when you install the
Marketing Platform.
Component

Description

Marketing
Platform utilities

Command line tools that allow you to work with the Marketing
Platform system table database from the command line to import and
export configurations, create partitions and data filters, and restore the
platform_admin user. Install this on every machine where you want to
be able to use Marketing Platform utilities.

Marketing
Platform web
application

The web application that supplies the common user interface, security,
and configuration management for IBM EMM. Install this on the
machine where you plan to deploy the Marketing Platform. Also, if
you are configuring additional machines where you want to be able
use the Marketing Platform utilities, you must also install the web
application because the utilities use the JAR files included in the web
application. You should not deploy on these additional machines.

Reports for IBM
Cognos® BI

Reports integration components for IBM Cognos. Install this
component only on the Cognos system.

Step: Obtain required information
The installer prompts you to enter some information about your Marketing
Platform system table database and web application server. Gather this information
before you start the installation.

Obtain connection information for the Marketing Platform
database
The installation wizards for all products must be able to communicate with the
Marketing Platform system table database, to register their menu items, security
information, and configuration properties. Each time you run the installer in a new
location, you must enter the following database connection information for the
Marketing Platform system table database.
v Database type.
v
v
v
v

Database host name.
Database port.
Database name or schema ID.
User name and password for the database account.

You obtained this information when you created the database or schema and filled
out the Marketing Platform database information checklist.
The master installer tests and validates this connection information when you
perform the installation.
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Obtain information about your deployment on the web
application server
Obtain the following information about your planned Marketing Platform
deployment.
v Protocol: HTTP or HTTPS if SSL is implemented in the web application server.
v Host: The name of the machine on which the Marketing Platform will be
deployed.
v Port: The port on which the web application server listens.
v Domain name: The company domain of each machine where IBM products are
installed. For example, mycompany.com. All IBM products must be installed in the
same company domain, and you must enter the domain name in all lower-case
letters.
If there is a mis-match in domain name entries, you may encounter problems
when you attempt to use Marketing Operations features or navigate among
products. You can change the domain name after the products are deployed by
logging in and changing values of the relevant configuration properties in the
product navigation categories on the Settings > Configuration page.

Obtain information required to enable Marketing Platform utilities
If you plan to use the Marketing Platform utilities, obtain the following JDBC
connection information before you start to install the Marketing Platform.
v Path to the JRE. The default value is the path to the 1.6 version of the JRE that
the installer places under your IBM installation directory.
You can accept this default or specify a different path. If you specify a different
path, you must point to the 1.6 version of the Sun JRE.
v JDBC driver class. The installer automatically provides this, based on the
database type you specifiy in the installer.
v JDBC connection URL. The installer provides the basic syntax, but you must
provide the host name, database name, and port.
v JDBC driver classpath on your system.
You obtained the last three pieces of information listed above when you created
the database or schema and filled out the Marketing Platform database information
checklist.

Step: Run the IBM installer
Before you run the IBM master installer, verify that you have met the following
prerequisites.
v You have obtained the software products you plan to install, and you have put
all of the installers in the same directory.
v You have available the information you gathered as described in “Step: Obtain
required information” on page 16.
If your company policy does not allow the installer to create and populate the
Marketing Platform system tables during installation, see “Step: Create and
populate the Marketing Platform system tables manually, if necessary” on page 18.
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Note: If you plan to deploy the Marketing Platform on WebLogic 9.2, do not
include the Marketing Platform in an EAR file. See the WebLogic guidelines
“Guidelines for deploying the Marketing Platform on WebLogic” on page 21 for
details.
See the other topics in this chapter for details about the installer, or if you need
help entering information in the wizard.
Run the IBM master installer as described here, and follow the instructions in the
wizard.
v GUI or X-windows mode
v

v

Run the Unica_Installer file. On UNIX-type systems, use the .bin file.
Console mode on Windows
Open a command prompt, and from the directory where you placed the IBM
software, run the Unica_Installer executable file with -i console. For example,
Unica_Installer_N.N.N.N_OS -i console
Console mode on UNIX-type systems

Run the Unica_installer.sh file with no switch.
On Solaris systems only, you must run the installer from a bash shell.
v Unattended mode
Open a command prompt, and from the directory where you placed the IBM
software, run the Unica_Installer executable file with -i silent. On UNIX-type
systems, use the .bin file.
For example, to specify a response file located in the same directory as the
installer:
Unica_Installer_N.N.N.N_OS -i silent
To specify a response file in a different directory, use -f filepath/filename .
Use a fully qualified path. For example:
Unica_Installer_N.N.N.N_OS -i silent -f filepath/filename
For more information about unattended mode, see “Installing multiple times
using unattended mode” on page 11.
Pay close attention to the installation summary windows. If errors are reported,
check the installer log files, and contact IBM technical support if necessary.

Step: Create and populate the Marketing Platform system tables
manually, if necessary
The IBM installer can create the Marketing Platform system tables during
installation, but if your company policy does not permit this, you must create and
populate the tables manually.
1. Run the IBM installer as described in “Step: Run the IBM installer” on page 17,
but with the following differences in your choices when it launches the
Marketing Platform installer.
v Select Manual database setup.
v Deselect the Run Platform configuration checkbox.
2. After the installer finishes, create the system tables manually by running the
following SQL scripts appropriate for your database type against your
Marketing Platform system table database, as described in “Creating system
tables” on page 103.
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Run the scripts in this order.
v ManagerSchema_DBType.sql
If you plan to support multi-byte characters (for example, Chinese, Japanese,
or Korean) and your database is DB2, use the
ManagerSchema_DB2_unicode.sql script.
v ManagerSchema__DBType_CeateFKConstraints.sql
v active_portlets.sql
v quartz__DBType.sql
3. Run the IBM installer again, making the following selections when it launches
the Marketing Platform installer.
v Select Manual database setup.
v Select the Run Platform configuration checkbox.
This will add default data to the system tables.

Chapter 3. Installing the IBM Marketing Platform
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Chapter 4. Deploying the IBM Marketing Platform
When you deploy the Marketing Platform in your web application server, you
must follow the guidelines described in this section.
When you ran the IBM installer, you may have included the Marketing Platform in
an EAR file, or you may choose to deploy the Marketing Platform's WAR file
(unica.war). If you included other products in an EAR file, you must follow all the
deployment guidelines detailed in the individual install guides for the products
included in the EAR file.
We assume that you know how to work with your web application server. Consult
your web application server documentation for details such as navigation in the
Administration console.

Guidelines for deploying the Marketing Platform on WebLogic
Follow the guidelines in this section when you deploy the Marketing Platform on
WebLogic.

All versions of WebLogic
Follow the guidelines in this section when you deploy the Marketing Platform
products on any supported version of WebLogic.
1.

2.

3.
4.

5.

IBM EMM products customize the JVM used by WebLogic. You may need to
create a WebLogic instance dedicated to IBM EMM products if you encounter
JVM-related errors.
Verify that the SDK selected for the WebLogic domain you are using is the Sun
SDK by looking in the startup script (startWebLogic.cmd) for the JAVA_VENDOR
variable. It should be set to: JAVA_VENDOR=Sun . If it is set to JAVA_VENDOR=BEA ,
JRockit has been selected. JRockit is not supported. To change the selected SDK,
refer to the BEA WebLogic documentation.
Deploy the Marketing Platform as a web application.
Only if your instance of WebLogic is configured to use a JVM version 1.6 or
newer, do the following to work around an issue with the time zone database.
v Stop WebLogic.
v Download the Timezone Updater tool from the Oracle web site:
http://www.oracle.com/technetwork/java/javase/tzupdater-readme136440.html
v Follow the steps provided by the Timezone Updater tool to update the time
zone data in your JVM.
If you are configuring WebLogic to use the IIS plug-in, review the BEA
WebLogic documentation.

Additional guidelines for WebLogic 10 and 11 G only
Follow the guidelines in this section when you deploy the Marketing Platform on
WebLogic 10 or 11 G.
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1. Only if your installation must support non-ASCII characters, for example for
Portuguese or for locales that require multi-byte characters, edit the
setDomainEnv script, located in the bin directory under your WebLogic domain
directory, as follows.
v Add the following to JAVA_OPTIONS.
-Dfile.encoding=UTF-8
2. In the WebLogic console, click the Domain link on the home page, and check
the Archived Real Path Enabled box on the Web Applications tab.
3. Restart WebLogic.
4. Deploy and start the EAR file or the WAR file (unica.war.

Guidelines for deploying the Marketing Platform on all versions of
WebSphere
Follow the guidelines in this section when deploying the Marketing Platform on
IBM WebSphere.
1. Be sure that the version of WebSphere meets the requirements described in the
IBM Enterprise Products Recommended Software Environments and Minimum
System Requirements document, including any necessary fix packs or upgrades,
including any necessary fix packs or upgrades.
2. Set a custom property in the server as follows.
v Name: com.ibm.ws.webcontainer.invokefilterscompatibility
v Value: true
See http://www-01.ibm.com/support/docview.wss?uid=swg21284395 for
instructions on setting a custom property in WebSphere.
3. Deploy the IBM EAR file or unica.war file as an enterprise application.
Follow the guidelines below. Unless otherwise noted below, you can accept
the default settings.
Ensure that the JDK source level of the JSP compiler is set to Java 15 and that
JSP pages are precompiled, as follows.
v In the form where you browse to and select the WAR file, select Show me
all installation options and parameters so the Select Installation Options
wizard runs.
v In step 1 of the Select Installation Options wizard, select Precompile
JavaServer Pages files.
v In step 3 of the Select Installation Options wizard, ensure that the JDK
Source Level is set to 15.
The context root must be the following.
v If you deploy a WAR file, name it /unica, all lower case.
v If you deploy an EAR file, name it /unica, all lower case.
4. In the server’s Web Container Settings > Web Container > Session
Management section, enable cookies.
5. Specify a different session cookie name for each deployed application. Use the
procedure that is appropriate for your deployment, as follows.
v If you deployed separate WAR files, in the WebSphere console, in the
server's Applications > Enterprise Applications > [deployed_application]
> Session Management > Enable Cookies > Cookie Name section, specify
a session cookie name that is unique.
v Select the Override session management checkbox.
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v If you deployed EAR files, in the WebSphere console, in the server's
Applications > Enterprise Applications > [deployed_application] >
Module Management > [deployed_module] > Session Management >
Enable Cookies > Cookie Name section, specify a session cookie name that
is unique.
v Select the Override session management checkbox.
6. Only if your installation must support non-ASCII characters, for example
for Portuguese or for locales that require multi-byte characters, add the
following to Generic JVM Arguments at the server level.
-Dfile.encoding=UTF-8
-Dclient.encoding.override=UTF-8
Navigation tip: select Servers > Application Servers > Java and Process
Management > Process Definition > Java Virtual Machine > Generic JVM
Arguments. See the WebSphere documentation for additional details.
7. In the server's Applications > Enterprise Applications section, select the EAR
file or WAR file that you deployed, then select Class loading and update
detection and set the following General Properties.
v If you are deploying a WAR file:
– For Class loader order, select Classes loaded with local class loader
first (parent last).
– For WAR class loader policy, select Single class loader for application.
v If you are deploying an EAR file:
– For Class loader order, select Classes loaded with local class loader
first (parent last).
– For WAR class loader policy, select Class loader for each WAR file in
application.
8. Start your deployment.
9. Only if your instance of WebSphere is configured to use a JVM version 1.6
or newer, do the following to work around an issue with the time zone
database.
v Stop WebSphere.
v Download the IBM Time Zone Update Utility for Java (JTZU) from the IBM
web site:
http://www.ibm.com/developerworks/java/jdk/dst/index.html
v Follow the steps provided by the IBM (JTZU) to update the time zone data
in your JVM.
10. Restart WebSphere.

Step: Verify your Marketing Platform installation
1. Access the IBM EMM URL using Internet Explorer.
If you entered a domain when you installed, the URL is the following, where
host is the machine where the Marketing Platform is installed, domain.com is
the domain in which the host machine resides, and port is the port number on
which the web application server listens.
http://host.domain.com:port/unica
2. Log in using the default administrator login, which is asm_admin with password
as the password.
You will be asked to change the password. You can enter the existing
password, but for good security you should choose a new one.
Chapter 4. Deploying the IBM Marketing Platform
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The default home page is the dashboard, which you will configure later. A
'page not found' message may be displayed on the dashboard page until it has
been configured.
3. Under the Settings menu, check the Users, User Groups, and User Permissions
pages to verify that the pre-configured users, groups, roles, and permissions are
present, as described in the Marketing Platform Administrator's Guide.
4. Add a new user and group and verify that data is entered into the Marketing
Platform system table database.
5. Under the Settings menu, check the Configuration page to verify that the
Marketing Platform configuration properties exist.
There are additional configuration tasks, such as configuring the dashboard, setting
up user access to IBM applications, and integrating with an LDAP or web access
control system (optional). See the IBM Marketing Platform Administrator's Guide for
instructions.
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Chapter 5. Configuring the IBM Marketing Platform After
Deployment
For a basic installation of the Marketing Platform, you must perform additional
configuration only under the following conditions.
v If you are using the IBM EMM reporting feature, see Chapter 8, “Installing
Reports,” on page 47
v If you have a particular password policy in mind, see “To change default
password settings” to determine whether you must change the default password
settings.
The Marketing Platform has additional properties on the Configuration page that
perform important functions that you can optionally adjust. See the context help
for the properties, or the IBM Marketing Platform Administrator's Guide to learn
more about what they do and how to set them.

To change default password settings
You set password policies on the IBM EMM Configuration page in the Unica >
General > Password settings category.
These password options apply only to passwords for internal users (created within
IBM EMM), not to users imported through synchronization with an external
system (such as Windows Active Directory, a supported LDAP directory server, or
web access control server). The exception is the Maximum failed login attempts
allowed property, which affects both internal and external users. Also note that this
property does not override any similar restriction set in an external system.
The default settings are as follows.
v Maximum failed login attempts allowed - 3
v Password history count - 0
v Validity (in days) - 30
v
v
v
v
v

Blank passwords allowed - True
Allow identical user name and password - True
Minimum number of numeric characters - 0
Minimum number of letter characters - 0
Minimum character length - 4

See the online help for descriptions of these properties.
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Chapter 6. Installing the IBM Marketing Platform in a Cluster
Use this procedure to install the Marketing Platform in a clustered environment
when you deploy on WebLogic 10 or any version of WebSphere.
The IBM EMM scheduler does not support clustering. Therefore, if you use the
IBM EMM scheduler with any of the following products, you should not use a
clustered installation of the Marketing Platform with that product.
v Campaign, when you use the IBM EMM scheduler for flowchart runs.
v Interaction History, which relies on the IBM EMM scheduler to set up data
loading and report generation.
Leads does not use the scheduler, so clustering is fully supported for an
environment that includes Leads alone.
Note: For upgrades, see Chapter 7, “Upgrading the IBM Marketing Platform,” on
page 29
1. Install one instance of the Marketing Platform.
2. Verify that your installation works.
3. Use your web application server's automatic deployment features to deploy the
EAR file in your cluster.
All machines in the cluster on which you deploy the Marketing Platform must
have network access to the database containing the Marketing Platform system
tables.
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Chapter 7. Upgrading the IBM Marketing Platform
Before you upgrade the Marketing Platform, be sure you have read and
understood “Upgrade prerequisites for all IBM EMM products” and “Marketing
Platform upgrade scenarios” on page 31.
Note: Although IBM changed the names of its Enterprise products with the 8.0.0.
release, some configuration categories and properties on the Configuration page
retain the 7.5.x names after upgrade, to provide continuity. Properties and
categories in new installations display the updated names.

Upgrade prerequisites for all IBM EMM products
To upgrade any IBM EMM product, you must meet all of the prerequisites listed
under “Prerequisites” on page 2 in the "Preparing to Install" chapter.
In addition, you must meet the prerequisites listed in this section.

Remove response files generated by previous installations
Before you run the installer to upgrade from pre-8.6.0 versions, you must delete
any response files generated by previous installations.
Old response files are not compatible with 8.6.0 and later installers because
changes were made to installer behavior and response file format.
Failure to remove old response files can result in having incorrect data pre-filled in
installer fields when the installer is run, or in the installer failing to install some
files or skipping configuration steps.
The response files are named installer_product.properties, except for the file for
the IBM installer itself, which is named installer.properties. The installer creates
these files in the directory where the installer is located.

User account requirement (UNIX only)
On UNIX, the same user account that installed the product must perform the
upgrade.

32-bit to 64-bit version upgrades
If you are moving from a 32-bit to a 64-bit version of an IBM EMM product,
ensure that the following conditions are met.
v The database client libraries for your product data sources are also 64-bit
v All relevant library paths (for example, startup or environment scripts) correctly
reference the 64-bit versions of your database drivers

Knowledge requirements
These instructions assume that the person performing the upgrade has an
understanding of the following.
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v The basic function of the IBM installer, as described in “How the IBM EMM
installers work” on page 9
v General IBM EMM product functionality and components, including the
structure of the file system
v The installation and configuration process for the source product version and for
the new version
v Maintaining configuration properties in your source and target systems
v The installation and configuration process for reports, if you are using these
reports

Oracle or DB2 only: auto commit requirement
If your Marketing Platform system tables are in Oracle or DB2, you must enable
auto commit for the environment open. See the Oracle or DB2 documentation for
instructions.

Upgrading Schedules with time zone support
In version 8.5.0, the Marketing Platform Scheduler allows you to select any of a
large number of world wide time zones for your tasks. If you had scheduled tasks
in your pre-8.5.0 version of the Marketing Platform, they will be set to the default
time zone, which is the time zone of the server on which the Marketing Platform is
installed.
To take advantage of the time zone support in the Scheduler, you should edit your
scheduled tasks and select the new time zone as needed. See the IBM Marketing
Platform Administrator's Guide for information about using the Scheduler.

If you have re-branded the IBM frameset
If you have re-branded the IBM frameset as described in the IBM Marketing
Platform Administrator's Guide, you must back up the files you modified before you
proceed with the upgrade, and restore them after you have completed the upgrade
installation but before you deploy your new version.
Typically, these files are the corporatetheme.css file and branding images. This file
and the images are located under the css\theme directory within the unica.war file.
Therefore, you should do the following.
1. Make a backup copy of the unica.war file before you start the upgrade
procedure.
2. Extract the unica.war file and set aside copies of your corporatetheme.css file
and branding images.
3. Proceed with the upgrade as described in this chapter, but do not deploy.
4. Extract the new unica.war file and overwrite the existing images and
corporatetheme.css file with your backed-up versions.
5. Re-war the new unica.war file, and deploy.
See the IBM Marketing Platform Administrator's Guide for additional details on
re-branding.
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Marketing Platform upgrade scenarios
Follow these guidelines for upgrading the Marketing Platform.
Source version

Upgrade path

Marketing Platform version
before 8.2.0 that is integrated
with an LDAP server

1. If you have mapped LDAP groups in the LDAP references for AM user
creation property that are not mapped in the LDAP reference to AM group
map property, you must do the following when in your current version of
the Marketing Platform before proceeding with the upgrade.
v Identify any groups in the LDAP references for AM user creation
property that are not mapped in the LDAP reference to AM group map
property.
v Map the LDAP groups you have identified to an appropriate Marketing
Platform group. After you perform an LDAP synchronization, you can
map these users to additional Marketing Platform groups to control their
application access as needed. For instructions, see the IBM Marketing
Platform Administrator's Guide.
Performing the previous steps ensures that all desired users are created in
the Marketing Platform.
2. Follow the upgrade procedures for your version, as shown in the remainder
of this table.

Pre-7.5.0 versions of Affinium
Manager

An upgrade from these versions directly to the Marketing Platform is not
supported. Perform the following steps.
1. Obtain the 7.5.1 Affinium Manager software and upgrade to that version.
Important: To upgrade from pre-7.5.0 versions of the Marketing Platform to
version 8.0.0 or later, you must first upgrade to version 7.5.1. The installation
guides packaged with the Manager 7.5.0 and 7.5.1 software contain an error.
If you use either of those guides, you may have problems with the upgrade.
Instead, you must follow the instructions in the corrected Affinium Manager
7.5.1 Installation Guide, which is available on Customer Central or by
contacting IBM Technical Support. (Although the software supports a direct
upgrade from any 7.5.x version to 8.1.x, the upgrade instructions in the
Affinium Manager 7.5.0 Installation Guide have not been corrected. Therefore, if
your version is pre-7.5.0, you must upgrade to version 7.5.1 and use the
corrected instructions.) To ensure that you have the corrected guide, look for
a publication date of July 6, 2010 or later on the title page.
2. Upgrade your 7.5.1 installation of Affinium Manager to the Marketing
Platform, as described in “To upgrade from Manager 7.5.x with automatic
migration” on page 39 or “To upgrade from Manager 7.5.x with manual
migration” on page 40 in this guide.

Affinium Manager version 7.5.x

1. Follow the instructions in “To upgrade from Manager 7.5.x with automatic
migration” on page 39 or “To upgrade from Manager 7.5.x with manual
migration” on page 40 in this guide.

Marketing Platform version 8.x

1. If you are upgrading from a version earlier than 8.2.0.7, follow the
instructions described in “To upgrade from version 8.x with automatic
migration” on page 32 or “To upgrade from version 8.x with manual
migration” on page 33.
2. If you are upgrading from version 8.2.0.7 or later, automatic upgrade is not
supported. Follow the instructions described in “To upgrade from version 8.x
with manual migration” on page 33.
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To upgrade from version 8.x with automatic migration
Upgrading from version 8.x is an in-place upgrade. You install to the directory
where your current Marketing Platform is installed.
Ensure that you have the following in one directory.
v The IBM master installer
v The Marketing Platform installer
A best practice is to do the following.
v Place the installers in the same directory where you originally placed the
installers for the earlier versions of your products.
v Remove any earlier versions of the IBM product installers from the directory, to
avoid having the master installer attempt to install the earlier versions.
1. Make a backup copy of your Marketing Platform system table database.
Important: Do not skip this step. If upgrade fails, you will not be able to roll
back your database and your data will be corrupted.
2. Undeploy your Marketing Platform deployment.
Depending on your web application server, you may have deployed a packed
or extracted dashboard.war file and a unica.war file, or you may have deployed
an EAR file containing the Marketing Platform. In 8.6.0 and later versions, the
dashboard is no longer in a separate WAR file.
3. Run the IBM master installer.
The IBM master installer starts. See “Step: Run the IBM installer” on page 17
for details on running the installer.
v When the IBM master installer prompts you to choose an installation
directory, choose the root IBM installation directory, not the Marketing
Platform installation directory which is under this IBM directory.
v When the IBM master installer prompts you to enter Marketing Platform
database connection information, enter the information that pertains to your
current Marketing Platform system tables.
The IBM master installer will pause and launch the Marketing Platform
installer.
4. Follow these guidelines in the Marketing Platform installer.
When the Marketing Platform installer asks whether you want to upgrade
Manager 7.5.x, select No.
v When the Marketing Platform installer prompts you for an installation
directory, select the directory of your current Marketing Platform installation,
usually named Platform.

v

v Select Automatic database setup.
v Follow all the remaining steps in the installation wizard, entering all
requested information.
5. Deploy your installation following the guidelines in Chapter 4, “Deploying the
IBM Marketing Platform,” on page 21.
6. Pay close attention to the installation summary windows. If errors are reported,
check the installer log files and contact IBM technical support if necessary.

32

IBM Marketing Platform: Installation Guide

To upgrade from version 8.x with manual migration
The Marketing Platform upgrade installer can perform all of the data migration
required for an upgrade automatically, but if your company does not allow this,
you must perform this procedure to upgrade manually.
This procedure applies only to upgrades from Marketing Platform version 8.x. See
“Marketing Platform upgrade scenarios” on page 31 for information on upgrading
from other versions.
Ensure that you have the following in one directory.
v The IBM master installer
v The Marketing Platform installer
v The installers for any product reports packages you want to upgrade
Also, ensure that your installation of Marketing Platform 8.x is fully functional and
that you can run the command line tools. This procedure requires the use of two
Marketing Platform utilities located in the tools/bin directory under your
Marketing Platform installation. Complete information on using these utilities,
including example commands for common tasks, is available as follows.
v “The populateDb utility” on page 97
v “The configTool utility” on page 89
1. Make a backup of your Marketing Platform system table database.
Important: Do not skip this step. If upgrade fails, you will not be able to roll
back your database and your data will be corrupted.
2. Undeploy your current version.
Depending on your web application server, you may have deployed a packed
or extracted dashboard.war file and a unica.war file, or you may have
deployed an EAR file containing the Marketing Platform. Undeploy both
components if they are deployed separately. In 8.6.0 and later versions, the
dashboard is no longer in a separate WAR file.
3. Run the IBM master installer.
The IBM master installer starts. Follow these guidelines in the IBM master
installer.
v When the IBM master installer prompts you to enter Marketing Platform
database connection information, enter the information that pertains to your
current Marketing Platform system tables.
v When the IBM master installer prompts you to choose an installation
directory, choose the root IBM installation directory, not the Marketing
Platform installation directory which is under this IBM directory.
The IBM master installer will pause and launch the Marketing Platform
installer.
4. Follow these guidelines in the Marketing Platform installer.
v When the Marketing Platform installer prompts you for an installation
directory, select the directory of your current Marketing Platform
installation, usually named Platform.
v When the installer asks whether you want to upgrade Manager 7.5.x, select
No.
v Allow the installer to back up your previous installation.
v Select Manual database setup.
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v Deselect the Run Platform configuration checkbox.
v Follow all the remaining steps in the Marketing Platform installer, entering
all requested information.
5. When the reports package installers launch, install the reporting schema
components.
6. After all of the installers finish, use the configTool utility to perform the
following steps to ensure that the SQL scripts you run in the next steps work
correctly.
a. Export all of your configuration properties, from the root node Affinium.
For example, the following command exports the properties to a file
named config_property_export.xml, which is written to the install
directory under your Marketing Platform installation. This is a Windows
example.
configTool.bat -x -p "Affinium" -f "C:\Unica\Platform\install\
config_property_export.xml
b. Delete all of the configuration properties, from the root node Affinium.
For example, the following command deletes the properties. This is a
Windows example.
configTool.bat -d -o -p "Affinium"
c. Import the configuration properties you exported.
For example, the following command imports the properties from a file
named config_property_export.xml, located in the install directory under
your Marketing Platform installation. This is a Windows example.
configTool.bat -i -o -f "C:\Unica\Platform\install\
config_property_export.xml
7. Only if you are upgrading from version 8.2.0.7 or later, perform the
following steps.
In the db\upgrade82to85 directory under your Marketing Platform installation,
edit a SQL script as follows.
a. The SQL script is ManagerSchema_DB_Type_85upg.sql, where DB_Type is the
database type of your system tables database
b. For all database types, remove the following statement.
ALTER TABLE USCH_RUN ADD PAYLOAD NVARCHAR(4000);
c. If your database is DB2, also remove the following statements.
ALTER TABLE qrtz_job_details ALTER COLUMN job_data SET DATA TYPE
blob(4000);
ALTER TABLE qrtz_triggers ALTER COLUMN job_data SET DATA TYPE
blob(4000);
8. Use the appropriate table below to locate the SQL scripts, provided with your
new Marketing Platform installation, against your Marketing Platform system
table database. Run the SQL scripts in the order shown.
Table 1. Use this table if you are upgrading from version 8.0.x
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Script Name

Location

ManagerSchema_DB_Type_81upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade80to81

ManagerSchema_DB_Type_8201upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to8201

ManagerSchema_DB_Type_85upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to85
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Table 1. Use this table if you are upgrading from version 8.0.x (continued)
Script Name

Location

insert_new_85_locales.sql

db\upgrade82to85

ManagerSchema_DB_Type_86upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade85to86

active_portlets.sql

db

Table 2. Use this table if you are upgrading from version 8.1.x or 8.2.0
Script Name

Location

ManagerSchema_DB_Type_8201upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to8201

ManagerSchema_DB_Type_85upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to85

insert_new_85_locales.sql

db\upgrade82to85

ManagerSchema_DB_Type_86upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade85to86

active_portlets.sql

db

Table 3. Use this table if you are upgrading from version 8.2.0.1 or a later patch version
Script Name

Location

ManagerSchema_DB_Type_85upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade82to85

insert_new_85_locales.sql

db\upgrade82to85

ManagerSchema_DB_Type_86upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade85to86

active_portlets.sql

db

Table 4. Use this table if you are upgrading from version 8.5.0.0
Script Name

Location

ManagerSchema_DB_Type_86upg.sql, where DB_Type is
the database type of your system tables database

db\upgrade85to86

active_portlets.sql

db

9. Use the populateDb utility to populate the system tables with default
Marketing Platform configuration properties, users and groups, and security
roles and permissions.
This utility is located in the tools/bin directory under your Marketing
Platform installation.
Example: populateDb -n Manager
See “The populateDb utility” on page 97 for complete usage details.
10. Use the configTool utility to import the scheduler configuration properties
required for Interaction History.
The configTool utility is located in the tools/bin directory under your
Marketing Platform installation.
Use the interaction_history_scheduler.xml file, located in the
conf/upgrade85to86 directory under your Marketing Platform installation.
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Example (Windows): configTool -i -p
"Affinium|suite|scheduler|taskRegistrations" -f C:\Unica\Platform\conf\
upgrade85to86\interaction_history_scheduler.xml
11. Use the configTool utility to import the scheduler configuration properties
required for Attribution Modeler.
Use the attribution_modeler_scheduler.xml file, located in the
conf/upgrade85to86 directory under your Marketing Platform installation.
Example (Windows): configTool -i -p
"Affinium|suite|scheduler|taskRegistrations" -f C:\Unica\Platform\conf\
upgrade85to86\attribution_modeler_scheduler.xml
12. Use the configTool utility to import the configuration properties required for
single sign-on with IBM Coremetrics®.
Use the coremetrics_configuration.xml and coremetrics_navigation.xml
files, located in the conf directory under your Marketing Platform installation.
Examples (Windows):
v configTool -i -p "Affinium" -f C:\Unica\Platform\conf\
coremetrics_configuration.xml
v configTool -i -p "Affinium|suite|uiNavigation|mainMenu|Analytics" -f
C:\Unica\Platform\conf\coremetrics_navigation.xml
13. Use the configTool utility to import the configuration properties required for
reporting.
Use the cognos10_integration.xml file, located in the conf/upgrade85to86
directory under your Marketing Platform installation.

14.

15.

16.
17.

Example (Windows): configTool -i -p "Affinium|Report|integrations" -f
C:\Unica\Platform\conf\upgrade85to86\cognos10_integration.xml
Use the configTool utility to remove JMS configuration properties that are no
longer used.
Examples (Windows):
v configTool -d -o -p "Affinium|suite|jmsServer"
v configTool -d -o -p "Affinium|suite|jmsPort"
Only if you are upgrading from version 8.2.0 or later, use the configTool
utility to import a new LDAP configuration property.
Use the LDAP_Anonymous_bind.xml file, located in the conf/upgrade85to86
directory under your Marketing Platform installation.
Example (Windows): configTool -i -p
"Affinium|suite|security|loginModes|LDAPPartitionLogin" -f
C:\Unica\Platform\conf\upgrade85to86\LDAP_Anonymous_bind.xml
To upgrade the dashboard, run the upgrade85Dashboard script, located in the
tools\bin directory under your Marketing Platform installation.
Update the Help > About page, as follows.
a. Use the configTool utility to export the Affinium | Manager | about
category (this category is not visible on the Configuration page, as it is
marked hidden).
Example (Windows): configTool -x -p "Affinium|Manager|about" –f
C:\Unica\Platform\conf\about.xml
b. Edit the exported XML file you just created (about.xml in the example) to
change the version number and display name, as follows.
Find the releaseNumber property and change the value to the current
version of the Marketing Platform. In the example, below, change 7.5.1 to
your new version.
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<property name="releaseNumber" type="string">
<displayNameKey>about.releaseNumber</displayNameKey>
<value>7.5.1</value>
</property>
c. Find the displayName property and change the value to the new name of
the product. In the example, below, change Affinium Manager to Marketing
Platform .
<property id="4" name="displayName" type="string_property"
width="40">
<value>Affinium Manager</value>
</property>
d. Use the configTool utility to import the revised file. You must use the –o
option to overwrite the node. Remember that you must specify the parent
node when you import.
Example (Windows): configTool –i –p “Affinium|Manager” –f
“about.xml” -o
18. Deploy and verify your installation as described in the chapter Chapter 4,
“Deploying the IBM Marketing Platform,” on page 21.
Note that the web component of Reports is no longer a separate deployment.
It is now included in the Marketing Platform and is deployed when you
deploy the EAR file that contains the Marketing Platform.
After you upgrade your IBM EMM applications, see Chapter 9, “Upgrading
reports,” on page 71 for additional steps required for reporting upgrades.

About upgrading from Affinium Manager 7.5.x
The installer automatically runs in upgrade mode when you allow it to search for
an installation of Affinium Manager 7.5.x to upgrade.
In upgrade mode, the Marketing Platform installer automatically migrates data
from your existing version of Affinium Manager. See “To upgrade from Manager
7.5.x with automatic migration” on page 39.
If your company policy does not allow you to use the installer to perform the
migration automatically, you can do this manually using the scripts provided with
your Marketing Platform installation. See “To upgrade from Manager 7.5.x with
manual migration” on page 40.

Files generated by automatic migration
The installer exports your Affinium Manager 7.5x configuration to an XML file
named Manager_config_upgrade7xto80.xml. The file is located in the install
directory under your Marketing Platform installation. When you choose automatic
migration, you do not have to do anything with this file during the upgrade
process. When you choose manual migration, you import these settings after you
update the database.
The installer generates an upgrade log named upgrade7xto80.log. The file is
located in the install directory under your Marketing Platform installation.
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Additional permissions required for the database user
When you run the installer to upgrade to the Marketing Platform, you must enter
database connection information for the Marketing Platform system table database,
just as you do when you perform a new installation. However, the database
account that you use must have the following rights in addition to the ones listed
in Step: Create the Marketing Platform system table database or schema.
v DROP TABLES
v DROP SEQUENCES (Oracle only)

What happened to Affinium Reports?
In version 8.x, reporting is one of the components provided by the Marketing
Platform. Reporting is no longer provided by a separate web application as it was
with Affinium Reports 7.5.x.
When you upgrade Affinium Manager 7.5x to Marketing Platform version 8.x, the
installer and database scripts also upgrade the reporting feature, although some
manual steps may be required. See Chapter 9, “Upgrading reports,” on page 71 for
details.

About the All Users group and upgrades
If your installation of Affinium Manager includes a user group named All Users,
this group is migrated to your new installation of the Marketing Platform. Any
application access assignments associated with your All Users group are retained,
except they are called roles in the Marketing Platform.
The only functional difference between the All Users group in Affinium Manager
and the migrated version of this group in the Marketing Platform is that when a
new user is created in the Marketing Platform, that user is not automatically added
to the All Users group.
You can continue to use the All Users group, or you can delete this group. If you
have been relying on this group to provide application access to users and you
delete it, you must provide former members of the group with equivalent roles in
Marketing Platform if you want those users to retain the permissions they had
before you upgraded.

Expected database changes
The following tables are not present in the Marketing Platform after upgrade
because they are no longer used.
v usm_otype
v usm_object
v usm_group
v usm_grp_obj_map
v usm_user_obj_map
In addition, some tables have new names. See the Marketing Platform system table
document for a description of the current Marketing Platform system table
database.
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To upgrade from Manager 7.5.x with automatic migration
This procedure applies only to upgrades from Affinium Manager version 7.5.x.
Ensure that you have the following in one directory.
v The IBM master installer
v The Marketing Platform installer
v The installers for any product reports packages you plan to upgrade
Also, ensure that your installation of Affinium Manager 7.5.x is fully functional
and that you can run the command line tools.
1. Use the configTool utility to export all of your old configuration settings.
v The utility is located in the tools/bin directory under your Affinium
Manager installation. See “The configTool utility” on page 89 for complete
usage details.
v Here is an example command.
configTool -x -f "path_to_any_directory/config_backup.xml"
This command creates a config_backup.xml file in the directory you specified
in the command. Verify that the file exists and contains all of your settings.
2. Make a backup of your Affinium Manager system table database.
Important: Do not skip this step. If upgrade fails, you will not be able to roll
back your database and your data will be corrupted.
3. Undeploy the Affinium Manager WAR file and the Reports WAR file.
4. Run the IBM installer.
v When the IBM master installer prompts you for the installation directory, you
may accept the default, create a new directory, or select any existing
directory. The directory you specify will become the root (parent) directory
for your product installation. Each product you install under this parent will
have its own sub-directory.
v When the IBM master installer prompts you for Marketing Platform database
connection information, enter the information that pertains to your Affinium
Manager 7.5.x system tables.
The IBM master installer will pause and launch the Marketing Platform
installer.
5. Follow these guidelines in the Marketing Platform installer.
v When the Marketing Platform installer asks whether you have a Manager
7.5.x installation that you want to upgrade, select Yes.
v Select your Affinium Manager 7.5.x installation directory as the upgrade
directory.
v Select Automatic database setup.
6. When the reports package wizards launch, install the reporting schema
components.
7. Obtain the database driver and create the JDBC connection to the Marketing
Platform system tables as described in “Step: Configure the web application
server for your JDBC driver” on page 6 and “Step: Create the JDBC connection
in the web application server” on page 6.
8. Deploy and verify your installation.
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Note that the web component of Reports is no longer a separate deployment. It
is now included in the Marketing Platform and is deployed when you deploy
the EAR file that contains the Marketing Platform.
Verify your installation as described in “Step: Verify your Marketing Platform
installation” on page 23.
After you upgrade your IBM EMM applications, see Chapter 9, “Upgrading
reports,” on page 71 for additional steps required for reporting upgrades.

To upgrade from Manager 7.5.x with manual migration
The Marketing Platform upgrade installer can perform all of the data migration
required for an upgrade automatically, but if your company does not allow this,
you must perform this procedure to upgrade manually.
This procedure applies only to upgrades from Affinium Manager version 7.5.x. See
“Marketing Platform upgrade scenarios” on page 31 for information on upgrading
from other versions.
Ensure that you have the following in one directory.
v The IBM master installer
v The Marketing Platform installer
v The installers for any product reports packages you want to upgrade
Also, ensure that your installation of Affinium Manager 7.5.x is fully functional
and that you can run the command line tools. This procedure requires the use of
two Marketing Platform utilities located in the tools/bin directory under your
Marketing Platform installation. Complete information on using these utilities,
including example commands for common tasks, is available as follows.
v “The populateDb utility” on page 97
v “The configTool utility” on page 89
1. Use the configTool utility to export all of your old configuration settings.
The utility is located in the tools/bin directory under your Affinium Manager
installation.
Here is an example command.
configTool -x -f "path_to_any_directory/config_backup.xml"
This command creates a config_backup.xml file in the directory you specified
in the command.
v Verify that the file exists and contains all of your settings.
v Make a note of the file name and location, as you will change the name and
move the file in a later step.
See “The configTool utility” on page 89 for complete usage details.
2. Make a backup of your Affinium Manager system table database.
Important: Do not skip this step. If upgrade fails, you will not be able to roll
back your database and your data will be corrupted.
3. Undeploy Affinium Manager WAR file and the Reports WAR file.
4. Run the IBM master installer.
The IBM master installer starts.
v When the IBM master installer prompts you for Marketing Platform
database connection information, enter the information that pertains to your
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Affinium Manager 7.5.x system tables. In some cases, the installer cannot
detect your previous Manager installation. In that case, you see an extra
confirmation window asking if you would like to continue. Click OK.
The IBM master installer pauses and launches the Marketing Platform
installer.
5. Follow these guidelines in the Marketing Platform installer.
v When the Marketing Platform installer asks whether you have a Manager
7.5.x installation that you want to upgrade, select Yes.
v When the installer prompts you for an installation directory, select or create
a directory different from your Affinium Manager 7.5.x installation
directory.
v Select Manual database setup.
v Deselect the Run Platform configuration checkbox.
v Follow all the remaining steps in the Marketing Platform installer, entering
all requested information.
6. When the reports package installers launch, install the reporting schema
components.
7. After all the installers finish, run the following SQL scripts, provided with
your new Marketing Platform installation, against your Affinium Manager
7.5.x system table database. Run the scripts in the order shown in the
following table.
Script Name

Location

0_Platform_Upgrade75to80_DropConstraints.sql

db\upgrade75to80

1_Platform_Upgrade75to80_DB_Type_backup.sql, where DB_Type is the
database type of your system tables database

db\upgrade75to80

2_Platform_Upgrade75to80_BackupData.sql

db\upgrade75to80

ManagerSchema80_DB_Type.sql, where DB_Type is the database type of
your system tables database

db\upgrade75to80
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Script Name

Location

ManagerSchema_DB_Type_81upg.sql, where DB_Type is the database type upgrade80to81
of your system tables database
Only if your system table database is SQL Server, you must do one
of the following.
v Open the script and edit it to add GO before and after the CREATE
TABLE statement "CREATE TABLE USM_DB_RESOURCE_BUNDLE(...);".
This part of the script should look like this when you have
completed the edit.
GO
CREATE TABLE USM_DB_RESOURCE_BUNDLE
(
ID BIGINT IDENTITY(1, 1) NOT NULL,
NAME VARCHAR(256) NOT NULL,
LOCALE VARCHAR(16),
APPLICATION INT,
BUNDLE_PROPERTIES VARCHAR(MAX),
PRIMARY KEY CLUSTERED (ID asc)
);
GO
Then run the script.
v Run this script one line at a time rather than all at once.
quartz_DB_Type.sql, where DB_Type is the database type of your
system tables database
v

Only if your system table database is Oracle or DB2 , use
3_Platform_Upgrade75to80_CopyDataToNewTables.sql

v

Only if your system table database is SQL Server, use
3_Platform_Upgrade75to80_CopyDataToNewTables_SQLServer.sql

ManagerSchema_DB_Type_8201upg.sql, where DB_Type is the database
type of your system tables database

db
db\upgrade75to80

db\upgrade82to8201

ManagerSchema_DB_Type_85upg.sql, where DB_Type is the database type db\upgrade82to85
of your system tables database
ManagerSchema_DB_Type_86upg.sql, where DB_Type is the database type db\upgrade85to86
of your system tables database
active_portlets.sql

db

8. Do the following with the file that contains your exported configuration
settings that you created in an earlier step. This enables the script to
automatically import your settings in the next step.
v Move or copy the file to the install directory under your new Marketing
Platform installation.
v Change the name of the file to Manager_config_upgrade7xto80.xml.
9. Run upgrade7xto80 (extension is .bat for Windows and .sh for UNIX). This
script is located in the tools/bin directory under your new Marketing
Platform installation.
If you see an error similar to the following, and your operating system is not
AIX®, perform the procedure described in “To obtain the latest JCE policy
files” on page 45 and then run the script.
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ERROR com.unica.manager.utils.KeyManager - Cannot retrieve the key from
the file [C:\...\Affinium\Manager\conf\kfile], cause: Illegal key size
10. Run the 4_Platform_Upgrade75to80_Drop7xTables.sql script against your
Affinium Manager 7.5.x system table database.
11. Run the insert_new_85_locales.sql script, located in the db\upgrade82to85
directory under your new Marketing Platform installation, against your
Affinium Manager 7.5.x system table database.
12. Perform the following steps to delete orphan records that could lead to errors
when you run the SQL in the next step.
v Run the following SQL against your Affinium Manager 7.5.x system table
database.
SELECT * FROM USM_ROLE_ROLE_MAP WHERE PARENT_ROLE_ID NOT IN (SELECT
ID FROM USM_ROLE)
SELECT * FROM USM_USER_ROLE_MAP WHERE USER_ID NOT IN (SELECT ID FROM
USM_USER)
v The records returned from these queries are orphan rows. Delete them.
13. Run the ManagerSchema_DB_Type_CreateFKConstraints.sql script against your
Affinium Manager 7.5.x system table database, where DB_Type is the database
type of your system tables database.
14. Use the populateDb utility to populate the system tables with default
Marketing Platform users and groups, and security roles and permissions.
Follow the steps shown here.
This utility is located in the tools/bin directory under your Marketing
Platform installation.
v First, you must edit the script file that runs the utility to increase memory,
as follows.
– Open the populateDb file in a text editor and find the line that looks like
this. The example shown is for Windows. The UNIX version will look
slightly different.
"%JAVA_HOME%\bin\java" -DUNICA_PLATFORM_HOME="
%UNICA_PLATFORM_HOME%" com.unica.manager.tools.PopulateDb %*
– Add -Xmx512m, followed by a space, just before -DUNICA_PLATFORM_HOME.
– Save and close the file.
v Next, run the populateDb utility.
Example: populateDb -n Manager
See “The populateDb utility” on page 97 for complete usage details.
15. Use the configTool utility to import the scheduler configuration properties
required for Interaction History.
The configTool utility is located in the tools/bin directory under your
Marketing Platform installation.
Use the interaction_history_scheduler.xml file, located in the
conf/upgrade85to86 directory under your Marketing Platform installation.
Example (Windows): configTool -i -p
"Affinium|suite|scheduler|taskRegistrations" -f C:\Unica\Platform\conf\
upgrade85to86\interaction_history_scheduler.xml
16. Use the configTool utility to import the scheduler configuration properties
required for Attribution Modeler.
Use the attribution_modeler_scheduler.xml file, located in the
conf/upgrade85to86 directory under your Marketing Platform installation.
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Example (Windows): configTool -i -p
"Affinium|suite|scheduler|taskRegistrations" -f C:\Unica\Platform\conf\
upgrade85to86\attribution_modeler_scheduler.xml
17. Use the configTool utility to register Marketing Platform menu items.
Use the config_navigation.xml file, located in the conf directory under your
Marketing Platform installation.
Example (Windows): configTool -i -p "Affinium|suite" -f
C:\Unica\Platform\conf\config_navigation.xml
If you are upgrading from version 8.x to the current version, go to step 18.
If you are upgrading from version 7.x to the current version, go to step 19.
18. Use the configTool utility to import the configuration properties required for
single sign-on with IBM Coremetrics.
Use the coremetrics_configuration.xml and coremetrics_navigation.xml
files, located in the conf directory under your Marketing Platform installation.
Examples (Windows):
v configTool -i -p "Affinium" -f C:\Unica\Platform\conf\
coremetrics_configuration.xml
v configTool -i -p "Affinium|suite|uiNavigation|mainMenu|Analytics" -f
C:\Unica\Platform\conf\coremetrics_navigation.xml
19. Use the configTool utility to import the configuration properties required for
reporting.
Use the cognos10_integration.xml file, located in the conf/upgrade85to86
directory under your Marketing Platform installation.
Example (Windows): configTool -i -p "Affinium|Report|integrations" -f
C:\Unica\Platform\conf\upgrade85to86\cognos10_integration.xml
20. Use the configTool utility to import a new LDAP configuration property.
Use the LDAP_Anonymous_bind.xml file, located in the conf/upgrade85to86
directory under your Marketing Platform installation.
Example (Windows): configTool -i -p
"Affinium|suite|security|loginModes|LDAPPartitionLogin" -f
C:\Unica\Platform\conf\upgrade85to86\LDAP_Anonymous_bind.xml
21. Update the Help > About page, as follows.
a. Use the configTool utility to export the Affinium | Manager | about
category (this category is not visible on the Configuration page, as it is
marked hidden).
Example (Windows): configTool -x -p "Affinium|Manager|about" –f
C:\Unica\Platform\conf\about.xml
b. Edit the exported XML file you just created (about.xml in the example) to
change the version number and display name, as follows.
Find the releaseNumber property and change the value to the current
version of the Marketing Platform. In the example, below, change 7.5.1 to
your new version.
<property name="releaseNumber" type="string">
<displayNameKey>about.releaseNumber</displayNameKey>
<value>7.5.1</value>
</property>
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c. Find the displayName property and change the value to the new name of
the product. In the example, below, change Affinium Manager to Marketing
Platform .
<property id="4" name="displayName" type="string_property"
width="40">
<value>Affinium Manager</value>
</property>
d. Use the configTool utility to import the revised file. You must use the –o
option to overwrite the node. Remember that you must specify the parent
node when you import.
Example (Windows): configTool –i –p “Affinium|Manager” –f
“about.xml” -o
22. Obtain the database driver and create the JDBC connection to the Marketing
Platform system tables as described in “Step: Configure the web application
server for your JDBC driver” on page 6 and “Step: Create the JDBC
connection in the web application server” on page 6.
23. Deploy your installation as described in Chapter 4, “Deploying the IBM
Marketing Platform,” on page 21.
Note that the web component of Reports is no longer a separate deployment.
It is now included in the Marketing Platform and is deployed when you
deploy the Marketing Platform.
24. Do the following before going to any other page in IBM EMM.
v Point your browser to http://host:port/unica/jsp/configmanager.jsp,
where host and port are appropriate values for your installation.
v Log in to IBM EMM as the asm_admin user.
v Go to the Settings > Configuration page.
v Verify the following configuration values and change them if necessary.
– General > Navigation > Unica® URL—This should be the URL for the
Marketing Platform, using a fully qualified host and port. For example,
http://myHost.myCompanyDomain.com:8080/unica.
– Affinium Suite > Domain name—This value must match the domain
used in the Marketing Platform URL, including case. In the above
example, this is myCompanyDomain.com
v Log out.
25. Go to the normal Marketing Platform URL, log in, and verify your installation
as described in “Step: Verify your Marketing Platform installation” on page 23.
26. If you have assigned data sources and data source passwords to any users,
check the data source passwords and re-set them manually, if necessary. You
will definitely have to do this if your operating system is AIX.
After you upgrade your IBM EMM applications, see Chapter 9, “Upgrading
reports,” on page 71 for additional steps required for reporting upgrades.

To obtain the latest JCE policy files
Perform this procedure if you see the following error when you run the
upgrade7xto80 script.
ERROR com.unica.manager.utils.KeyManager - Cannot retrieve the key from the
file [C:\...\Affinium\Manager\conf\kfile], cause: Illegal key size
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Note that this workaround does not apply when the Marketing Platform is
installed on AIX. In that case, after you complete the upgrade, you must log in to
IBM EMM and change data source passwords manually.
This procedure ensures that you have the latest Java Cryptography Extension (JCE)
Unlimited Strength Jurisdiction Policy Files 5.0.
Download these files here: http://java.sun.com/javase/downloads/index_jdk5.jsp
Scroll to Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy
Files 5.0 and do the following.
1. Ensure that the JRE in your Manager 7.5.x installation has the updated JCE
Unlimited Strength Jurisdiction files. Follow instructions in the download to
copy the local_policy.jar and US_export_policy.jar to the jre/lib/security
directory.
2. Use encryptPasswords -k to encrypt your keystore password again.
3. If you are NOT using the JRE provided in the Marketing Platform installer, also
update the JCE Unlimited Strength Jurisdiction files for the JRE you intend to
use.
4. Run the Marketing Platform installer and your keys will be migrated to 8.x.
If the JCE updates are not made, or if you were unable to use the workaround
because your Marketing Platform system table database is AIX, you may see these
errors:
Cannot retrieve the key from the file [<INSTALL_DIR>\Affinium\Manager\conf\
kfile], cause: Illegal key size
javax.crypto.BadPaddingException: pad block corrupted
If these errors occur, when your upgrade is complete, log in to IBM EMM and
change data source passwords manually.

Upgrading in a clustered environment
Use the following guidelines when you upgrade multiple instances of Affinium
Manager to Marketing Platform in a clustered environment.
v Undeploy all of the instances of Affinium Manager and Affinium Reports.
v Uninstall all instances of Affinium Manager except one.
v Follow the directions in this chapter to upgrade.
v Follow the clustering instructions in Chapter 6, “Installing the IBM Marketing
Platform in a Cluster,” on page 27.
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Chapter 8. Installing Reports
For its reporting feature, IBM EMM integrates with IBM Cognos BI, a third-party
business intelligence application. Reporting relies on the following components:
v An installation of IBM Cognos BI
v A set of IBM EMM components that integrate the IBM system with the IBM
Cognos installation
v For Campaign, eMessage, and Interact, reporting schemas that enable you to
build reporting views or tables in the application’s system tables
v The example reports for the IBM EMM application(s), built with IBM Cognos
Report Studio
The Marketing Platform provides the IBM side of the reporting integration. To
install reporting, you do the following:
v Install the reporting schemas from the application report package on the
machine where the Marketing Platform is installed.
v Set up the reporting views or tables.
v Install the IBM integration components and report models on the IBM Cognos
system.
This chapter describes how to install and set up reporting for your IBM
applications. For information about the individual components and how they
interact with each other, see the IBM Marketing Platform Administrator's Guide.

Install reporting components
Installing and configuring IBM EMM product report packages is a multi-step
process. Perform the tasks in this section in the order shown to install reports.

Step: Set up a user with the ReportsSystem role, if necessary
Configure a user with access to the IBM EMM Settings > Configuration and
Settings > Report SQL Generator pages so you can log in as this user when you
need to configure the reporting properties and generate the SQL used to create
reporting schema.
The easiest way to do this is to assign the ReportSystem role to the
platform_admin user. This role is under Report > PartitionN on the User Roles
and Permissions page.
See “To assign a role to or remove a role from a user” for general information on
performing this task.

To assign a role to or remove a role from a user
1. Click Settings > Users.
The Users page displays.
2. Click the name of the user account that you want to work with.
The user detail page displays a list of the user's attributes, roles, groups, and
data sources.
3. Click Edit Roles.
© Copyright IBM Corp. 1999, 2012
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The Edit Roles page displays. Roles that are not assigned to the user are shown
in the Available Roles box on the left. Roles that are currently assigned to the
user are shown in the Roles box on the right.
4. Click a role name in the Available Roles box to select it.
The selected role name is highlighted.
5. Click Add or Remove to move the role name from one box to the other.
6. Click Save Changes to save your changes.
A window displays the message, Save Successful.
7. Click OK.
The user details display in the right pane, with your changes shown in the
Roles list.

Step: Install the reporting schemas on the IBM EMM system
Use the IBM master installer and the reports package installers to install the
desired reporting schemas on the machine where the Marketing Platform is
installed. See “How the IBM EMM installers work” on page 9 for detailed
information on the IBM installers.
Follow these guidelines when the reports package installer launches.
1. In the ReportsPackProduct Components window, select Reporting Schema.
2. If more than one option appears in the Schema Type Selection window, it
means that the IBM application has prepackaged custom attributes. Do one of
the following:
a. To install reporting schemas that include the custom attributes, select
Custom. The sample reports for Campaign are configured to use custom
attributes. Therefore, if you are installing the Campaign report package and
you want the sample reports to function correctly, you must select this
option.
b. To install reporting schemas that do not include the custom attributes, select
Base.
The installer places the reporting schema in the file system and registers the
schema with the Marketing Platform.
3. Verify that the reporting schema are registered in the Marketing Platform, as
follows.
a. Log in to the IBM EMM system as the platform_admin user.
b. Select Settings > Configuration.
c. Expand Reports > Schemas > ProductName.
If you see the schema configuration properties for your application, you
installation is complete.
If the schema configuration properties for your application are not present, the
report package has not been registered, and you must register them manually
as described in the next step.
4. Only if the schema configuration properties are not present, register them
manually as follows.
a. Edit the import_all script and edit it as follows.
The script is located in the tools directory under your reports package
installation.
Set the value of the MANAGER_TOOLS_BIN_DIR variable to the path of the
tools/bin directory under your Marketing Platform installation.
b. Run the script.
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The script invokes the Marketing PlatformconfigTool utility and registers
the schemas.
c. Verify that the schema configuration properties are present.

Step: Determine which authentication mode to configure
The IBM Authentication Provider is one of the components that integrates the IBM
Cognos Business Intelligence system with IBM EMM. This component enables the
IBM Cognos BI applications to use IBM authentication to communicate with the
IBM EMM system as though it were another IBM application in the suite.
There are three authentication options: anonymous, authenticated, and
authenticated per user.
v Anonymous means authentication is disabled. You use this mode to test your
configuration without the added complication of authentication settings.
v Authenticated means that the communications between the IBM system and the
IBM Cognos system are secured at the machine level. You configure a single
system user and configure it with the appropriate access rights. By convention,
this user is named "cognos_admin."
v Authenticated per user means that the system evaluates individual user
credentials.
Determine which authentication mode you need to configure. For a complete
description of these options, see "Reporting and security" in the IBM Marketing
Platform Administrator's Guide.

Step: Create JDBC data sources
The IBM EMM Reports SQL Generator tool must be able to connect to the IBM
EMM application databases to generate SQL scripts that create reporting tables, .
The SQL Generator can generate SQL scripts that create views or materialized
views without access to the these application databases, but it cannot validate the
SQL without a data source connection.
In the application server hosting the Marketing Platform, configure a JDBC data
source for each IBM EMM application for which you want to enable reporting. Use
the default JNDI name listed below. If you do not use the default JNDI names
described in the following tables, make a note of what they are so you can specify
the correct name of the data source when you run the SQL Generator tool.
IBM application

Default JNDI name

Campaign

campaignPartition1DS
If there are multiple partitions, create a data source for
each partition.

eMessage

campaignPartition1DS for the system tables
eMessagePartition1TrackingDS for the tracking tables

Interact

campaignPartition1DS for the design-time database
InteractRTDS for the runtime database
InteractLearningDS for the learning tables
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If you need additional help with this task, see the application server
documentation. See also the section on creating JDBC data sources in the
installation guide for your IBM application.

Optional step: Obtain email server information
If you want report results to be sent through email, obtain the following
information.
v Host name or IP address of your SMTP server
v User name and password for the account on that server
v Email address for the default sender email

Set up the reporting views or tables
To implement reporting for Campaign, eMessage, and Interact, you create
reporting views or tables from which the reports extract reportable data. This
section describes how to run the Reports SQL Generator, which uses the reporting
schemas to generate view or table creation scripts. You then run those scripts on
the IBM application database to create the views or tables.

Configuration checklist: reporting views or tables
The following list provides a high level overview of the steps to perform when
configuring the reporting schemas from an IBM Reports Package. Each step is
described in detail later in this section.
1. “Step: Load the templates for the Reports SQL Generator”
2. “Step: Generate the view or table creation scripts.”
3. “Step: Create the reporting views or tables” on page 51.
4. “Step for tables and materialized views only: Set up data synchronization” on
page 55.

Step: Load the templates for the Reports SQL Generator
The reports packages for IBM EMM applications that have reporting schemas
contain a SQL script that loads template SQL select statements into the
uar_common_sql table. The Reports SQL Generator uses these templates when
generating the SQL scripts for creating the reporting views or tables. In this task,
you run the script that loads the templates.
1. Navigate to the schema directory under your report pack installation and locate
the templates_sql_load.sql script.
2. Run the templates_sql_load.sql script in the Marketing Platform database.

Step: Generate the view or table creation scripts
Complete the following steps.
1. Log in to IBM EMM as the platform_admin user (or another user with access
to the Report SQL Generator menu item).
2. Only if you did not use the default JNDI names for the JDBC data sources
you created in an earlier step, do the following.
a. Select Settings > Configuration > Reports > Schemas > ProductName .
b. Change the default values of the JNDI property to match the JNDI names
you gave the JDBC connections in an earlier step.
3. Select Settings > Reports SQL Generator.
4. In the Product field, select the appropriate IBM application.
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5. In the Schema field, select one or more reporting schemas.
6. Select the Database Type.
7. In the Generate Type field, select the appropriate option (views, materialized
views, or tables).
Materialized views are not an option when Database Type is set to MS SQL
Server.
If the JNDI data source names are incorrect or have not been configured, the
SQL Generator cannot validate the SQL.scripts that create tables.
8. Ensure that Generate Drop Statement is set to No.
The first time you run the view or table creation scripts there are no existing
views or tables to drop so there is no need to create drop scripts.
9. (Optional.) To examine the SQL that will be generated, click Generate. The
SQL Generator creates the script and displays it in the browser window.
10. Click Download.
The SQL Generator creates the script and prompts you to specify where you
want to save the file. If you selected a single reporting schema from the
Schema field, the script name matches the name of schema
(eMessage_Mailing_Performance.sql, for example). If you selected more than
one reporting schema, the script name uses the product name only
(Campaign.sql, for example). For a complete list of names, see “SQL script
names and where to run them.”
11. Specify the location where you want to save the script. If you change the
name of the file, be sure to use something that clearly indicates which
schemas you selected. Then click Save.
12. Repeat steps 5 through 12 for each script you need to generate.
Note: The Interact reporting schemas reference more than one data source.
Generate a separate SQL script for each data source.
There may be times when you want to disable script validation. For example,
perhaps the Marketing Platform cannot connect to the IBM application
database but you want to generate the scripts anyway. To disable validation,
clear the data source names from the data source fields (see step 3, above).
When you generate the scripts, the SQL Generator displays a warning that it
cannot connect to the data source, but it still generates the SQL script.

Step: Create the reporting views or tables
The steps you perform to create views or materialized views are different from
those you perform to create reporting tables. In both cases, however, there are extra
steps when generating views or tables for Interact.
Complete one or more of the following, as appropropriate for your installation.
Refer to “SQL script names and where to run them” as necessary.
v
v
v
v

“Create
“Create
“Create
“Create

views or materialized views for Campaign or eMessage” on page 52
views or materialized views for Interact” on page 52
and populate reporting tables for Campaign or eMessage” on page 53
and populate reporting tables for Interact” on page 54

SQL script names and where to run them
This table shows the system table database or databases where each SQL script
should be run (for views or materialized views). These are the scripts that you
created in a previous step, using the SQL Generator.
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Reporting
schema
All Campaign
reporting
schemas

System tables

Script name (default names)

Campaign system tables

Campaign.sql, unless you generate separate
scripts for each reporting schema. If you do,
each script is named after the individual
schema. For example, the default name for
the SQL file generated for the Campaign
Performance schema is
Camapign_CampaignPerformance.sql.

eMessage Mailing eMessage tracking tables
Performance

eMessage_Mailing_ Performance.sql

Campaign system tables
Interact
Deployment
History, Interact
Performance, and
Interact Views

Interact.sql

Interact Learning

Interact_Learning.sql

Interact Learning tables

Interact Run Time Interact run time database Interact_Runtime.sql

Create views or materialized views for Campaign or eMessage
1. Locate the SQL scripts that you generated and saved previously. Refer to “SQL
script names and where to run them” on page 51 if necessary.
2. Use your database administration tools to run the appropriate script against the
appropriate application database(s) for the report package you are configuring.
Note: When you run a script that creates materialized views on a DB2
database, your database may return the error "SQL20059W The materialized
query table-name may not be used to optimize the processing of queries."
However, the materialized view is successfully created.
3. For Campaign with a DB2 database only, increase the DB2 heap size to 10240
or higher. (The default heap size is 2048.) Use the following command:
db2 update db cfg for databasename using stmtheap 10240
where databasename is the name of the Campaign database.
Increasing the heap size ensures that IBM Cognos does not display SQL error
messages if a user selects all the campaigns when running a report like the
Financial Summary report.

Create views or materialized views for Interact
1. Verify that the language setting of the client from which you will run the
lookup_create SQL script is UTF-8.
For examples of how to do this for Oracle and DB2, see “Setting the language
in Oracle and DB2” on page 53.
2. Locate the SQL scripts that you generated and saved previously. Refer to “SQL
script names and where to run them” on page 51 if necessary.
3. Use your database administration tools to run the appropriate script against the
appropriate application database(s) for the report package you are configuring.
Note: When you run a script that creates materialized views on a DB2
database, your database may return the error "SQL20059W The materialized
query table-name may not be used to optimize the processing of queries."
However, the materialized view is successfully created.
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4. Locate the tools subdirectory in the reports package installation directory and
find the lookup_create script for your database type. For example, the script
for SQL is named uari_lookup_create_MSSQL.sql, and so on.
Run this script on the the Interact design time database. Ensure that the
database tool you are using commits the changes. For example, you may need
to set the database's auto-commit option to true.
5. Locate the db/calendar subdirectory in the Marketing Platform installation
directory and find the ReportsCalendarPopulate script appropriate for the
database type. This script creates two more tables: UA_Calendar and UA_Time.
6. Run this script on the Interact run time database (InteractRTDS).
For DB2 only, do one of the following:
v Either run the script from the command line using the command db2 -td@
-vf ReportsCalendarPopulate_DB2.sql
v Or, if you use the DB2 client interface, change the termination character to
the @ character in the Statement termination character field.
Setting the language in Oracle and DB2:
Oracle example
For example, for Windows and Oracle:
1. Close any open Oracle sessions.
2. Open the Registry Editor.
3. Navigate to HKEY_LOCAL_MACHINE > SOFTWARE > ORACLE and open
the folder for your Oracle Home (ex. KEY_OraDb10g_home1).
4. Search for the NLS_LANG setting.
5. Make sure the last part of the value specified is UTF8. For example:
AMERICAN_AMERICA.UTF8.
DB2 example
For example, for DB2, from the machine that is running the script and has the DB2
client installed, run a DB2 command window. Then run the following command:
db2set
In the output, look for the following variable/value pair: DB2CODEPAGE=1208
If this variable is not set, run the following command
db2 db2set db2codepage=1208
Then close the session window so the change can take effect.

Create and populate reporting tables for Campaign or eMessage
1. Create the new reporting database.
2. Locate the SQL scripts that you generated and saved previously. Refer to “SQL
script names and where to run them” on page 51 if necessary.
3. Use your database administration tools to run the generated script(s) in the
new database.
4. For Campaign and a DB2 reporting database only, increase the DB2 heap size
to 10240 or higher. (The default heap size is 2048.) Use the following command:
db2 update db cfg for databasename using stmtheap 10240
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where databasename is the name of the reporting database.
Increasing the heap size ensures that Cognos does not display SQL error
messages if a user selects all the campaigns when running a report like the
Financial Summary report.
5. Locate the db/calendar subdirectory of the Marketing Platform installation and
find the version of the ReportsCalendarPopulate script appropriate for the
database type. This script creates two more tables: UA_Calendar and UA_Time.
6. Run the ReportsCalendarPopulate script on the new database that you created
with the table creation script.
For DB2 only, do one of the following:
v Either run the script from the command line using the command db2 -td@
-vf ReportsCalendarPopulate_DB2.sql
v Or, if you use the DB2 client interface, change the termination character to
the @ character in the Statement termination character field.
7. Use your database administration tools to populate the new tables with the
appropriate data from the production system database.
Note: Note that you must use your own tools for this step. The SQL Generator
does not generate this SQL for you.

Create and populate reporting tables for Interact
1. Create the new reporting databases.
2. Locate the SQL scripts that you generated and saved previously. Refer to “SQL
script names and where to run them” on page 51 if necessary.
3. Use your database administration tools to run the generated script(s) in the
new database.
4. Locate the db/calendar subdirectory in the Marketing Platform installation
directory and find the lookup_create script for your database type. For
example, the script for SQL Server is named uari_lookup_create_MSSQL.sql,
and so on.
Run this script on the tables that represent the Interact design time database.
Ensure that the database tool you are using commits the changes. For example,
you may need to set the database's auto-commit option to true.
5. Locate the db/calendar subdirectory in the Marketing Platform installation
directory and find the ReportsCalendarPopulate script appropriate for the
database type. This script creates two more tables: UA_Calendar and UA_Time.
6. Run this script on both the set of tables that represents the Interact design time
database and the tables that represent the Interact run time database.
For DB2 only, do one of the following:
v Either run the script from the command line using the command db2 -td@
-vf ReportsCalendarPopulate_DB2.sql
v Or, if you use the DB2 client interface, change the termination character to
the @ character in the Statement termination character field.
7. Use your database administration tools to populate the new tables with the
appropriate data from the production system database.
Note: Note that you must use your own tools for this step. The SQL Generator
does not generate this SQL for you.
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Step for tables and materialized views only: Set up data
synchronization
If you created materialized views, be sure to use your database administration
tools to schedule regular data synchronization between the production databases of
the IBM EMM application and the materialized views.
If you created reporting tables, be sure to use scheduled ETL (Extraction,
Transformation and Load) or any custom method to schedule regular data
synchronization, between the the production databases of the IBM EMM
application and the new reporting tables.

Install and test IBM Cognos BI
If your license agreement with IBM grants you an IBM Cognos BI license, you can
download the IBM Cognos BI installation media from the IBM Customer Central
website.

IBM Cognos BI, IBM reporting, and domains
Before you begin, determine whether you are installing IBM Cognos BI in the same
domain as the IBM EMM suite. As a best practice, you are encouraged to install
IBM Cognos and the IBM EMM system in the same domain. If you do not, you
must configure both IBM Cognos and IBM EMM to use SSL.
Note: After you install IBM Cognos BI, be sure to use Cognos Configuration to
configure the Cognos URLs appropriately. On a Windows system, the default
values for these URLs use the machine name "localhost." You must replace the
"localhost" placeholder with the fully qualified host name, including domain.

IBM Cognos BI applications
IBM Cognos BI is a collection of several applications, servers, and services,
organized in a multi-tiered architecture. When you use IBM Cognos BI with your
IBM EMM suite, you use the following subset of Cognos BI applications:
v IBM Cognos BI Server, which provides storage for reports and folders (plus the
queries and metadata models), the Content Manager, and so on.
v IBM Cognos Connection, a web application that you use to import, configure,
and schedule the reports. This application also provides access to the following
additional components:
– Cognos Viewer: used for displaying reports. Cognos Viewer is the module
that displays the reports in your IBM EMM applications.
– Report Studio: used for customizing reports and creating new ones. When
you purchase IBM Cognos BI from IBM you are typically granted a license for
one report author only.
– Cognos Administration: used for configuring data sources, and so on.
v IBM Cognos Framework Manager, the metadata modeling tool that you use to
configure and customize the Cognos data model that supports the IBM Cognos
BI reports for your IBM EMM application.
v IBM Cognos Configuration, the configuration tool that you use to configure
individual Cognos BI components.

Chapter 8. Installing Reports

55

IBM Cognos BI installation options and Cognos
documentation
Before you install IBM Cognos BI, use the IBM Cognos BI Architecture and
Deployment Guide to learn about the various components, the installation options,
and the configuration approaches recommended by IBM Cognos.
The IBM Cognos documentation uses two general categories to describe
installations: installing in a distributed environment versus installing all the
components on one computer. For best results, do not install all components on
one computer unless it is for a proof of concept or is a demonstration environment.
Installing the subset of IBM Cognos BI applications that IBM reporting uses
requires that you use two IBM Cognos installers. One provides the IBM Cognos BI
server, the Content Manager, Cognos Configuration, and the Web-based user
interfaces. You use a separate installer to install Framework Manager, the metadata
modeling tool, because it must be installed on a Windows machine.
If you are installing all components on one computer you can use the IBM Cognos
Quick Start Installation and Configuration Guide. If you are installing in a distributed
environment, use the full installation guide, IBM Cognos BI Installation and
Configuration Guide.

IBM Cognos BI web applications and the web server
IBM does not provide the web server that hosts Cognos Connection and the other
IBM Cognos BI web applications. For Windows, the IBM Cognos documentation
assumes that you are using Microsoft IIS (Internet Information Services) but you
can also use Apache HTTP.
If you use the Apache HTTP server, take care to set up the web aliases for the
Cognos web applications in the VirtualHost configuration directive of the Apache
httpd.conf file correctly: be sure to order the most specific alias first (the script
alias) and set directory permissions for each alias.
Example httpd.conf code snippet
The following example is from an Apache installation on a Windows system. The
Apache server is running on the default port 80.
<VirtualHost *:80>
ScriptAlias /cognos10/cgi-bin "C:/cognos/cgi-bin"
<Directory "C:/cognos/cgi-bin">
Order allow,deny
Allow from all
</Directory>
Alias /cognos10 "C:/cognos/webcontent"
<Directory "C:/cognos/webcontent">
Order allow,deny
Allow from all
</Directory>
</VirtualHost>

Note: This httpd.conf file snippet is an example only. Be sure to configure your
web aliases appropriately for your systems.
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IBM Cognos BI and locale
If you plan to install a localized version of your IBM EMMapplication report
package (other than English), be sure to set the product locale to match the
language of the application report package.
On the system running the Cognos Content Manager, open Configuration Manager,
select Actions > Edit Global Configuration, and configure the locale for the IBM
Cognos BI system. For more information, see the IBM Cognos Configuration User
Guide, available from the Help menu in Configuration Manager.

Test the IBM Cognos BI installation
Test your IBM Cognos installation using the following guidelines.
v Stop and restart the Cognos BI server and check the cogserver.log file for
errors. The file is located in the logs directory of your Cognos installation.
v Verify that database tables exist in the Cognos content store. There should be
approximately 134 tables.
If you have a distributed Cognos environment with components installed on
different machines, for example Cognos BI server on a UNIX system and
Framework Manager installed on a Windows machine, do the following.
v Verify that you can communicate with the internal and external dispatcher and
the Content Manager from the machine where the Gateway is installed. To test
components that do not have a user interface, enter the URI of the component in
a browser’s address field. A Cognos page should appear in the browser.
v Open Framework Manager and start to create a project. This test ensures that
you can log in. Check the log file again for errors.

Install IBM EMM integration components and report models on the
Cognos system
To integrate the IBM EMM suite with Cognos, you need the following installers.
v The IBM EMM master installer—You always run this installer to launch the
other installers
v The Marketing Platform installer—You install the Cognos integration component
from this installer
v The reports pack installer or installers for the products for which you want to
implement reporting—You install the reports archive containing the models and
sample reports from this installer
After you perform the installation, you perform the following configuration steps,
as described in the remainder of this section.
v Configure IBM EMM and Cognos reporting properties in the Marketing Platform
interface
v Import the report into Cognos Connection
v Configure Cognos to use IBM EMM authentication

Installation checklist: IBM Cognos integration
The following list provides a high level overview of how to install and configure
the IBM components and reports on the IBM Cognos system. Each step is
described in detail later in this section.
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1. “Step: Obtain the JDBC driver for the Marketing Platform system tables.”
2. “Step: Install the reporting models and integration component on the IBM
Cognos system.”
3. “Step: Create the IBM Cognos data sources for the IBM EMM application
databases” on page 59.
4. “Optional step: Set up email notification” on page 60.
5. “Step: Configure the IBM Cognos application's firewall” on page 60.
6. “Step: Import the reports folder in Cognos Connection” on page 61.
7. “Step: Configure and publish the data model, if necessary” on page 61.
8. “Step: Enable internal links in the reports” on page 62.
9. “Step: Verify the data source names and publish” on page 62.
10. “Step: Configure Cognos reporting properties in the Marketing Platform” on
page 63.
11. “Step: Test your configuration without authentication enabled” on page 63.
12. “Configure IBM Cognos to use IBM EMM authentication” on page 64.
13. “Step: Test your configuration with authentication configured” on page 67.

Step: Obtain the JDBC driver for the Marketing Platform
system tables
Obtain the JDBC drivers and any required associated files that you used to
configure the JDBC data source for the Marketing Platform's system tables when
you set up the IBM EMM system. In a task later in this chapter, you configure
Cognos to use IBM EMM authentication. Cognos needs the JDBC driver so it can
obtain user information from the Marketing Platform system tables when it uses
IBM EMM authentication.
Copy the JDBC driver to the machine where the Cognos Content Manager is
installed, to the webapps\p2pd\WEB-INF\AAA\lib directory under your Cognos
installation.

Step: Install the reporting models and integration component
on the IBM Cognos system
If yours is a distributed Cognos installation, determine which machine is running
the Cognos Content Manager so you can run the IBM installer on this machine.
1. Stop the IBM Cognos service.
2. On the machine where the Cognos Content Manager is installed, place the
following IBM installers in a single directory.
v IBM master installer
v Marketing Platform
v The reports pack installer or installers for the products for which you want
to implement reporting
3. Run the IBM master installer, and select the Marketing Platform and Reports
packages you want to install.
4. Following the prompts, enter the connection information for the Marketing
Platform system table database.
5. When the Marketing Platform installer launches and the Platform Installation
Components window appears, select the Reports for IBM version Cognos BI
option and clear the other options.
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6. When the Marketing Platform installer prompts for the path to the JDBC driver,
enter the fully qualified path for the JDBC driver you copied to the Cognos
system during the task “Step: Obtain the JDBC driver for the Marketing
Platform system tables” on page 58.
7. When the Marketing Platform installer prompts for the location of the IBM
Cognos installation, enter or browse to the top level of the IBM Cognos
installation directory. The default value provided in this field is a static value
that is not based on the actual file structure of your IBM Cognos system.
8. When the report pack installer or installers displays installation options, select
the IBM Cognos Package for Product, and clear the option for the reporting
schemas.
This option copies the reports archive to the Cognos machine. You import this
archive later.
9. Restart the IBM Cognos server.

Step: Create the IBM Cognos data sources for the IBM EMM
application databases
The IBM Cognos applications need their own data sources that identify the IBM
EMM application databases; that is, the source of the data for the reports. The IBM
Cognos data models provided in the IBM EMM reports packages are configured to
use the following data source names:
Table 5. Cognos data sources
IBM EMM application

Cognos data source name(s)

Campaign

CampaignDS

eMessage

eMessageTrackDS

Interact

InteractDTDS for the design time database
InteractRTDS for the runtime database
InteractLearningDS for the learning database

Marketing Operations

MarketingOperationsDS

Leads

LeadsDS for the data mart tables

Use the following guidelines to create Cognos data sources for the IBM application
databases:
v Use the Administration section of Cognos Connection.
v Use the default data source names that are shown in the Cognos data sources
table. That way you can avoid having to alter the data model.
v The database type you select must match that of the IBM application database.
Use the Cognos documentation and help topics to determine how to fill out
database-specific fields.
v Be sure that you identify the IBM EMM application database and not the
Cognos content store.
v When you configure the Signon section, select the Password and Create a
Signon that the Everyone group can use options.
v In the Signon section, specify the user credentials for the IBM EMM application
database user.
v Consult the Cognos data sources table and ensure that you create all the data
sources required by the data model for the reports you are configuring. For
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example, the reporting data for Interact is located in three databases so you must
create separate Cognos data sources for each one.
v If the Campaign system has more than one partition, create separate data
sources for each partition. For example, if Campaign is configured for multiple
partitions, create a separate Campaign data source for each partition.
v Verify that you have configured each data source correctly by using the Test
Connection feature.
If you have any questions about configuring Cognos data sources, see the IBM
Cognos Administration and Security Guide, "Chapter 6: Data Sources and
Connections" and the Cognos online help.

Optional step: Set up email notification
When an IBM Cognos report is displayed in the IBM EMM interface, the Cognos
Viewer toolbar in the window includes an option for sending the report as an
attachment in an email. If you want to enable IBM Cognos to send IBM EMM
reports as email attachments, configure notification in Cognos Configuration.
Use the following guidelines to set up email notification for the IBM EMM
application reports:
v In Cognos Configuration, select Data Access > Notification.
v Specify the SMTP mail server using the host name or the IP address plus the
port using the format host:port or IPAddress:port. For example, serverX:25 or
192.168.1.101:25. (The default SMTP port is usually 25.)
v To set the user name and password of the account, click in the Value column
and click the pencil icon to open the Value dialog box.
v Specify the default sender using the pattern user@company.com.
If you have any questions about configuring email notification, see the Cognos
Connection online help.
Note: When a user selects the email option from the Cognos Viewer toolbar, the
email form that appears includes the option to insert a link to the report. When
you acquire your IBM Cognos license from IBM EMM, this option is not
supported. Users can send the reports as email attachments only.

Step: Configure the IBM Cognos application's firewall
To configure the IBM Cognos firewall, you specify the IBM EMM system as a valid
domain or host and disable validation.
1. In Cognos Configuration, select Security > IBM Cognos Application Firewall.
2. Set Enable CAF validation to false.
3. In the valid domains or hosts property, enter the fully qualified machine host
name, including the domain and the port, for the system where the Marketing
Platform is running.
Important: If you have a distributed IBM EMM environment, you must do this
for every machine on which an IBM EMM product that renders Cognos reports
is installed (for example, the Marketing Platform, which has dashboards;
Campaign; and Marketing Operations).
For example:
serverXYZ.mycompany.com:7001
4. Save the configuration.
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5. Restart the IBM Cognos service.

Step: Import the reports folder in Cognos Connection
The IBM EMM application reports are in the compressed (.zip) file the report
package installer copied to the IBM Cognos machine. Use the guidelines in this
procedure to import the compressed file for reports into Cognos Connection.
1. Navigate to the Cognosnn directory under your report package installation on
the IBM Cognos machine, where nn indicates the version number.
2. Copy the compressed reports archive file (for example IBM EMM Reports for
Campaign.zip) to the directory where your Cognos deployment archives are
saved. In a distributed IBM Cognos environment, this is a location on the
system running the Content Manager.
The default location is the deployment directory under your IBM Cognos
installation and it is specified in the Cognos Configuration tool installed with
the Cognos Content Manager. For example: cognos\deployment.
3. Locate the Cognosnn\ProductNameModel subdirectory under your report
package installation on the Cognos machine.
4. Copy the entire subdirectory to any place on the system running Cognos
Framework Manager that Framework Manager has access to.
5. Open Cognos Connection.
6. From the Welcome page, click Administer Cognos Content.
If your Welcome page is turned off, turn it back on in the Cognos Connection
user preferences.
7. Click the Configuration tab.
8. Select Content Administration.
(New Import) on the toolbar.
9. Click
10. Follow these guidelines as you step through the New Import Wizard:
a. Select the reports archive that you copied in the previous procedure.
b. In the Public folders content list, select all the options, including the
package itself (the blue folder).
c. If you do not want users to access the package and its entries yet, select
Disable after import. Make this selection if you want to test the reports
before you make them available to the IBM EMM application users.

Step: Configure and publish the data model, if necessary
In “Step: Create the IBM Cognos data sources for the IBM EMM application
databases” on page 59, you set up the IBM EMM system tables as a Cognos data
source. If the data source login you used is not the owner of the IBM EMM
application system tables, perform the step described here. If the data source login
you used does own the IBM EMM application system tables, then you can skip
this step.
1. Locate the Model directory under the reports package installation. Copy all of
the files in this Model directory to anywhere under your Cognos Framework
Manager installation directory. These files constitute the application-specific
data model.
2. In Framework Manager, open the project file. The project file has a .cpf
extension and the file name includes the IBM EMM application name (for
example, ProductNameModel.cpf).
3. Open the data model for the application and do the following.
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a. In the Project Viewer, expand Data Sources.
b. Click the data source for the application.
c. Update the data source as described in the following table.
Database

Fields

SQL Server

v Catalog: Enter the name of the IBM EMM application database.
v Schema: Enter the name of the IBM EMM application database
schema. For example, dbo

Oracle

v

DB2

v Schema: Enter the name of the IBM EMM application database
schema.

Schema: Enter the name of the IBM EMM application database
schema.

4. Save and republish the package.
If you need basic instructions on publishing a package in IBM Cognos, see the
Cognos Framework Manager User Guide.

Step: Enable internal links in the reports
The IBM EMM application reports have standard links. To enable these links to
work properly, you must configure the Cognos firewall as described in “Step:
Configure the IBM Cognos application's firewall” on page 60, and you must
configure the redirect URL in the Cognos data model (the .cpf file) for the IBM
EMM application reports, as follows.
1. From Cognos Framework Manager, browse to the <productName>Model
subdirectory you copied into the Framework Manager directory structure and
select the .cpf file. For example, CampaignModel.cpf.
2. Select Parameter Maps > Environment.
3. Right click Environment and select Edit Definition.
4. In the Redirect URL section, select the Value field. Edit the server name and
port number so they are correct for the IBM EMM system, leaving the rest of
the URL intact. By convention, the host name includes the domain name.
For example, for Campaign:
http://serverX.ABCompany.com:7001/Campaign/
redirectToSummary.do?external=true&
For example, for Marketing Operations:
http://serverX.ABCompany.com:7001/plan/callback.jsp?
5. Save the model and publish the package:
a. From the navigation tree, expand the Packages node of the model.
b. Right click the package instance and select Publish Package.

Step: Verify the data source names and publish
When you publish the model from Framework Manager to the Cognos content
store, the name specified as the data source for the reports in the model must
match the name of the data source you created in Cognos Connection. If you used
the default data source names as described in “Step: Create the IBM Cognos data
sources for the IBM EMM application databases” on page 59, the data source
names match. If they do not, you must change the name of the data source in the
model.
1. In Cognos Connection, determine the names of the data sources you created.
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2. In Framework Manager, select the Open a Project option.
3. Browse to the <productName>Model subdirectory you copied into the Framework
Manager directory structure and select the .cpf file. For example,
CampaignModel.cpf.
4. Expand the Data Sources entry and examine the names of the data sources.
Verify that they match what you named them in Cognos Connection.
a. If they match, you are finished with this procedure.
b. If they do not match, select the data source instance and edit the name in
the Properties section. Save your changes.
5. Publish the package to the Cognos content store

Step: Configure Cognos reporting properties in the Marketing
Platform
There are several sets of properties for configuring reporting in IBM EMM. Some
specify parameter values for the reporting components in the Marketing Platform.
You have already set these properties, as described in “Step: Generate the view or
table creation scripts” on page 50.
Other properties specify URLs and other parameters for the IBM Cognos system.
This procedure describes how to set these Cognos properties.
1. Log in to IBM EMM as the platform_admin user or another user with the
ReportsSystem role.
2. Select Settings > Configuration > Reports > Integration > Cognos version
3. Set the value of the Enabled property to True.
4. Set the value of the Domain property to the name of the company domain on
which the IBM Cognos system is running.
For example, xyzCompany.com.
If your company uses subdomains, the value in this field should include the
company domain and the subdomain.
5. Set the value of the Portal URL property, to the URL of the Cognos Connection
portal. Use a fully qualified host name, including the domain and any
subdomains (specified in the Domain property).
For example: http://MyCognosServer.xyzCompany.com/cognos10/cgi-bin/
cognos.cgi
You can find this URL in the Cognos Configuration utility under Local
Configuration > Environment.
6. In the Dispatch URL field, specify the URL of the primary Cognos Content
Manager dispatcher. Use a fully qualified host name, including the domain and
any subdomains (specified in the Domain property).
For example: http://MyCognosServer.xyzCompany.com:9300/p2pd/servlet/
dispatch
You can find this URL in the Cognos Configuration utility under Local
Configuration > Environment.
7. Leave Authentication mode set to anonymous for now.
8. Save the settings.

Step: Test your configuration without authentication enabled
After the reports are installed and configured but before you enable authentication,
test the setup by running some reports.
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1. Verify that IBM EMM is running and that the IBM Cognos BI service is
running.
2. Log in to IBM EMM as a user with application access and create some data.
(Otherwise the reports have nothing to show.)
3. Open Cognos Connection.
4. Navigate to the report folders you imported and click the link to a basic report.
For example, for Campaign, select Public Folders > Campaign > Campaign >
Campaign Summary.
If the report fails, verify that you configured the Cognos data source for the
IBM EMM application database correctly. See “Step: Create the IBM Cognos
data sources for the IBM EMM application databases” on page 59.
5. Click a link in the report.
If the internal links from the reports do not work, the redirect URL is not
configured correctly. See “Step: Enable internal links in the reports” on page 62.
6. Log in to the IBM EMM application as a user with application access and
navigate to the Analysis page.
When you specify the URL for the IBM EMM application, be sure to use a fully
qualified host name with your company domain (and subdomain, if
appropriate). For example:
http://serverX.ABCompany.com:7001/unica
7. Click the link to the same report that you tested in Cognos.
If you cannot view the report, it is likely that the IBM Cognos firewall isn't
configured correctly. See “Step: Configure the IBM Cognos application's
firewall” on page 60.
8. Click a link in the report.
If the internal links from the reports do not work, the redirect URL is not
configured correctly. See “Step: Enable internal links in the reports” on page 62.
9. Open an individual item, click the Analysis tab, and verify that the report is
correct.

Configure IBM Cognos to use IBM EMM authentication
The IBM EMM Authentication Provider enables the Cognos applications to use
IBM EMM authentication to communicate with the IBM EMM system as though it
were another IBM EMM application in the suite.
Before you begin the procedures in this section, be sure that you know which
authentication mode you plan to configure ("authenticated" or "authenticated per
user). If you need more information, see “Step: Determine which authentication
mode to configure” on page 49.

Step: Create the reporting system user, if necessary
Note: If you are setting the authentication mode to "authenticated per user" skip
this procedure and continue to “Step: Configure the Cognos authentication
properties in IBM EMM” on page 65.
When you create the reports system user, you create the user and add data source
credentials to the user that holds login information for IBM Cognos BI. In this way,
you configure two sets of logins for the same user:
v One for the IBM system: the user name and password specified for the reports
system user (cognos_admin)
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v One for IBM Cognos BI: the user name and password specified as data source
credentials for the reports system user
1. Log in to IBM EMM as the platform_admin user.
2. Select Settings > Users.
3. Create an IBM user with the following attributes:
a. User name: cognos_admin
b. Password: admin
4. Create a new data source for the user with the following attributes:
a. Data Source: Cognos
b. Data Source Logon: cognos_admin
Ensure that the user name in the data source exactly matches the user name
of the IBM user you created in step 3.
c. Data Source Password: admin
5. Add the Reports System role to the user.
6. If IBM EMM is configured to expire user passwords, log out and then log back
in as the reporting system user (cognos_admin). This step ensures that you
interact with the IBM security "change password" challenge and reset the
password before you log in to IBM Cognos as this user in a later task.

Step: Configure the Cognos authentication properties in IBM
EMM
1. Log in to IBM EMM as the platform_admin user.
2. Select Settings > Configuration.
3. Expand Reports > Integrations > Cognos version .
4. Set the value of the Authentication Mode property by selecting either
authenticated or authenticatedPerUser, as appropriate for your system.
5. For "authenticated" only. Verify that the values in the Authentication user
name and Authentication datasource name fields match those of the user and
data source you created in the previous task, “Step: Create the reporting system
user, if necessary” on page 64.
6. Set the value of the Enable form authentication property.
This setting indicates that IBM EMM security uses form-based authentication in
place of cookies. You set this property to True when either of the following is
true.
v When the IBM EMM is not installed in the same network domain as the
Cognos applications.
v When Cognos is accessed using an IP address (within the same network
domain) instead of the Fully Qualified Hostname (which is being used to
access the IBM EMM applications), even if both the IBM EMM applications
and the Cognos installation are on the same machine.
However, when the value is True, the login process to Cognos Connection
passes the login name and password in clear text and therefore is not secure
unless Cognos and the IBM EMM are configured to use SSL communication.
Even with SSL configured, the user name and password appear as clear text in
the HTML source code when you "view source" in a displayed report. For this
reason, you should install Cognos and IBM EMM in the same network domain.
Note that when the Enable form authentication property is set to True, the
Authentication mode property automatically behaves as though it were set to
authenticated, and you must perform the step required for this mode,
described in “Step: Create the reporting system user, if necessary” on page 64.
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7. Save the new settings.
8. For "authenticatedPeruser" only. Assign the ReportUser role to the default
asm_admin user. You perform this step so that you can test reports: you need a
user with access to both the IBM EMM application and report data. The
platform_admin user does not have access to the IBM EMM application
features.

Step: Configure IBM Cognos to use the IBM EMM Authentication
Provider
In this task, you use the Cognos Configuration and Cognos Connection
applications to configure the IBM Cognos BI applications to use the IBM EMM
Authentication Provider.
1. On the machine running the Cognos Content Manager, open Cognos
Configuration
2. Select Local Configuration > Security > Authentication.
3. Right-click Authentication and select New resource > Namespace.
4. Complete the fields as follows, and then click OK:
a. Name: Unica
b. Type: Custom Java Provider.
5. On the Resource Properties page, complete the fields as follows and then save
your changes:
a. NamespaceID: Unica
b. Java class name:
com.unica.report.adapter.UnicaAuthenticationProvider
6. Stop and restart the IBM Cognos BI service.
On a Windows system, sometimes the Cognos interface indicates that the
service is stopped when it is not. To ensure that the service has really stopped,
use the Windows Administrative tools to stop the service.
7. Under Local Configuration > Security > Authentication, right-click Unica
and select Test.
If Cognos Connection displays an error, examine the cogserver.log file,
located in the logs directory of your Cognos installation to determine the
problem.
8. Log in to Cognos Connection as follows to verify that the IBM EMM
Authentication provider is configured correctly:
v If you set the Cognos authentication mode in the IBM EMM configuration
properties to authenticated, log in as the cognos_admin (report system)
user.
v If you set the authentication mode in the IBM EMM configuration
properties to authenticatedPerUser, log in as the asm_admin user.
If IBM Cognos displays the error "The 3rd party provider returned an
unrecoverable exception," expand the error message. If it states "invalid
credentials," you made an error entering your user credentials. Try again.
However, if it states "password expired," IBM EMM expired the password.
Log in to IBM EMM application as the reporting system user and reset the
password. Then try logging in to Cognos Connection again.
If you still cannot log in to Cognos Connection, examine the cogserver.log
file, located in the logs directory of your Cognos installation, to determine the
problem.
9. When you can successfully log in to Cognos Connection, open Cognos
Configuration again.
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10. Select Local Configuration > Security > Authentication > Cognos.
11. Disable anonymous access to IBM Cognos BI by setting Allow anonymous
access? to false.
12. Save your changes.
13. Stop and restart the IBM Cognos service.
If the IBM Cognos service cannot communicate successfully with the
authentication provider, it cannot start. If the IBM Cognos service fails to start,
verify your configuration by retracing the steps in this procedure.
14. Distributed systems only. If your IBM Cognos system has backup Content
Managers configured for failover support, repeat this procedure on all the
servers with Content Manager installed.
At this point, anyone logging in to an application on the Cognos system must be
authenticated by IBM EMM. Additionally, the authentication namespace Unica
now appears in the IBM Cognos user interface for logon and security
administration tasks.

Configuration required when the IBM Marketing Platform is
integrated with an LDAP server or a web access control system
When the IBM Marketing Platform is integrated with an LDAP server, Windows
Active Directory (Windows Integrated Login), or a web access control system such
as Tivoli® or SiteMinder, you must perform the following additional configurations.
1. In Cognos Configuration, set the flag Selectable for authentication to false for
the Unica authentication namespace.
When you set this flag to false, Cognos Connection and Cognos Administration
cannot access the Unica namespace for the purpose of authentication. However,
IBM EMM applications can still access the Unica namespace via the Cognos
SDK API (for example, when users view Cognos reports from within IBM
EMM applications).
2. If you need authenticated access to the Cognos URL, do the following.
a. In Cognos Configuration, configure a namespace using the appropriate
bundled authentication provider.
b. Set Selectable for authentication to true.
c. Use this new namespace for the Cognos URL.

Step: Test your configuration with authentication configured
After configuring IBM Cognos to use IBM EMM authentication, test the system
again.
1. Verify that IBM EMM is running and that the IBM Cognos service is running.
2. Open Cognos Connection.
3. Navigate to the report folders you imported and click the link a basic report.
For example, for Campaign, select Public Folders > Campaign > Campaign >
Campaign Summary.
If the report fails, verify that you configured the IBM Cognos data source for
the IBM EMMapplication database correctly. See “Step: Create the IBM Cognos
data sources for the IBM EMM application databases” on page 59.
4. Click a link in the report.
If the internal links from the reports do not work, the redirect URL is not
configured correctly. See “Step: Enable internal links in the reports” on page 62.
5. Log in to IBM EMM and navigate to the Analysis page.
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When you specify the URL for the IBM EMM application, be sure to use a fully
qualified host name with your company domain (and subdomain, if
appropriate). For example:
http://serverX.ABCompany.com:7001/unica
6. Click the link to the same report that you tested in IBM Cognos.
If you see error messages about security, it is likely that the IBM EMM
Authentication Provider is not configured correctly. See “Configure IBM Cognos
to use IBM EMM authentication” on page 64.
If you are prompted to enter credentials for authentication, it is likely that the
domain name is missing from one of your URLs. Log in to IBM EMM as a user
with admin privileges. Then select Settings > Configuration and ensure that
the URLs in the following properties include the domain name and any
appropriate subdomain name.
v Reports > Integration > Cognos > Portal URL and Dispatch URL
v Any URL properties for the IBM EMM applications, for example: Campaign
> navigation > serverURL
7. Click a link in the report.
If you are prompted to enter credentials for authentication, it is likely that the
domain name is missing from one of the URLs.
8. Open an individual item, click the Analysis tab, and verify that the report is
correct.
If you see error messages about security, it is likely that the IBM EMM
Authentication Provider is not configured correctly.

Next steps for reporting
At this point, reporting is working properly and the example reports are in their
default state. When you finish configuring the actual data design of your IBM
EMM applications - things like campaign codes, custom campaign attributes,
response metrics, and so on - you will return to reporting because you may need
to customize the reports or reporting schemas.
v If you are using Campaign or Interact, see the "Configuring reporting" chapter in
the Marketing Platform Administrator's Guide.
v If you are using Marketing Operations, see the "Using Reports" chapter in the
IBM Marketing Operations Administrator's Guide.
v If you are setting up reporting for eMessage, you are done configuring
reporting. You cannot customize the eMessage reporting schemas or the reports.
v If you configured the system to use the "authenticated per user" mode, ensure
that the appropriate IBM EMM users can run the reports from the IBM EMM
applications. The easiest way to do this is to assign the default ReportsUser role
to the appropriate user groups or users, as described in “To configure report
folder permissions.”

To configure report folder permissions
In addition to controlling access to the Analytics menu item and the Analysis tabs
for object types (campaigns and offers, for example), you can configure
permissions for groups of reports based on the folder structure in which they are
physically stored on the IBM Cognos system.
1. Log in as a Campaign administrator who has the ReportSystem role.
2. Select Settings > Sync Report Folder Permissions.
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The system retrieves the names the folders located on the IBM Cognos system,
for all partitions. (This means that if you decide to configure folder permissions
for any partition, you must configure it for all of them.)
Select Settings > User Permissions > Campaign.
Under the Campaign node, select the first partition.
Select Add Roles and Assign Permissions.
Select Save and Edit Permissions.
On the Permissions form, expand Reports.
The Reports entry does not exist until after you run the Sync Report Folder
Permissions option for the first time.
8. Configure the access settings for the report folders appropriately and then save
your changes.
9. Repeat steps 4 through 8 for each partition.
3.
4.
5.
6.
7.
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Chapter 9. Upgrading reports
In IBM EMM version 8.x, reporting is one of the components provided by the
Marketing Platform. That is, IBM EMM reporting is no longer provided in a
separate web application as it was in Affinium Reports 7.5.x.
When you upgrade to Marketing Platform version 8.x, the installer and database
scripts also upgrade the reporting feature, retaining the configuration settings for
the Campaign and Interact reporting schemas. This chapter describes how to
upgrade and configure the other reporting components.

About upgrading from version 7.5.1
When you install the IBM Cognos reports archive from the reports package, you
run an upgrade script that preserves your customizations to the Cognos data
model, but you must replace the 7.5.1 reports with the new reports. Although the
majority of the older reports are compatible with the upgraded Cognos models, the
8.x reports packages include new and enhanced reports, and most of the packages
also contain Dashboard reports. The only way to obtain the new or enhanced
reports is to install the 8.x reports archive, which overwrites the existing reports.
Therefore, you have two options for upgrading your reports.
v Back up the old reports, install the new reports, and then recreate your
customizations using the old reports for reference.
v Back up the old reports and install the new reports. Compare the new reports to
your old reports and examine your customizations. If you are certain that a
customized report will function properly with the new data model, copy the old
customized report back into the reports folder.
Note that the 7.5.1 version of the Campaign Performance by Cell reports and the
Offer Performance Summary by Campaign reports do not function at all without
manual intervention. Additionally, the new versions of many of the old reports
include enhancements and minor bug fixes. This chapter includes procedures that
describe how to manually fix the old Campaign Performance by Cell reports and
the Offer Performance Summary by Campaign reports so they function with the
new model. This chapter does not describe how to manually apply the
enhancements or minor fixes to the other 7.5.1 reports. To obtain those changes,
you must use the new versions of the reports.

Upgrade scenarios
Source version

Upgrade path

Pre-7.5.1

If you are upgrading an IBM EMM application from a pre-7.5.1
version, there is no upgrade path for reporting. Instead, see Chapter 8,
“Installing Reports,” on page 47.

7.5.1

If you are upgrading an IBM EMM application from the 7.5.1 version,
perform the following steps.
v

“Preparing to upgrade the reporting components” on page 72

v

“Upgrading reports from version 7.5.1” on page 73

Note: Because there is no upgrade path for eMessage from version
7.5.x to 8.x, there is also no upgrade path for the eMessage reports.
© Copyright IBM Corp. 1999, 2012
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Source version

Upgrade path

8.x

If you are upgrading an IBM EMM application from an 8.x version,
perform the steps described in:
v

“Preparing to upgrade the reporting components”

v

“Upgrading reports from version 8.x” on page 84

Preparing to upgrade the reporting components
Before you begin upgrading and configuring reporting, complete the preparatory
tasks in this section.

Step: Verify that a user with the ReportsSystem role exists
If you are upgrading from version 7.x you must configure an IBM EMM user with
appropriate permissions to work with reporting. If you are upgrading from 8.x,
this user probably exists already.
If you do need to configure this reporting user, see “Step: Set up a user with the
ReportsSystem role, if necessary” on page 47 for instructions.

Confirm that the reporting schemas and reports integrations
settings are upgraded on the Marketing Platform
If you have not done so already when you upgraded the Marketing Platform, you
must run the IBM EMM master installer with the reports packs installers to
upgrade the reporting schemas.
Take the following steps to verify that the upgraded reporting schemas and reports
integration configuration properties are on the Marketing Platform.
1. Log in to the IBM EMM system as the platform_admin user.
2. Select Settings > Configuration.
3. Expand Reports > Schemas > ProductName .
If the schema configuration categories for your application were not upgraded,
you have not yet installed the report package on this IBM EMM system. Locate
the appropriate report package installer, run it now, and select the IBM EMM
Product Reporting Schemas installation option.
Note: If you are upgrading Marketing Operations, skip this step (Marketing
Operations does not have reporting schemas).
4. Expand Reports > Integrations.
If the schema configuration categories were upgraded, you will see a new
category for Cognos 10 configuration. Your Cognos 8 category is disabled, but
it is retained for reference purposes, to assist you in setting the configuration
properties for Cognos 10. After you have fully configured and tested your
reporting upgrade, you should use the Delete Category link to remove the
Cognos 8 configuration category.

Back up the Cognos model and report archive
On the IBM Cognos BI system, complete the following tasks:
v Make a back up copy of the model subdirectory. That is, locate the application
model installed by the IBM EMM reports package installers, and copy the entire
model subdirectory to create a backup.
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v Use the export deployment specification feature in Cognos Connection to create
a backup of the application's reports archive. Export the entire content store.

Step: Upgrade IBM Cognos BI, if necessary
If necessary, upgrade your version of IBM Cognos BI to the version supported for
the report packs you are installing.
For help with this task, see the IBM Cognos BI documentation.
After you upgrade Cognos, perform the Cognos configuration tasks described in
the installation chapter of this guide.

Upgrading reports from version 7.5.1
Follow the steps in this section if you are upgrading an IBM EMM application
from version 7.5.1.

Step: Upgrade the reporting schemas and the views or
reporting tables
Note: If you are upgrading Marketing Operations, skip this step and continue to
“Step: Obtain the JDBC driver for the Marketing Platform system tables” on page
58. (Marketing Operations does not have reporting schemas.)
After you have upgraded Affinium Manager to Marketing Platform (including
running the report pack installer with the Marketing Platform installation),
complete the following steps:
1. Navigate to the Unica\[product]ReportsPack\schema directory and locate the
templates_sql_load.sql script.
2. Run the script in the Marketing Platform system tables database.
3. Ensure that the Marketing Platform is running.
4. Log in to IBM EMM as a user with administrator privileges.
5. Under Settings > Users, give yourself the ReportsSystem role. Then log out
and log back in.
6. Campaign only. The database schema for adding new campaign attributes
changed in Campaign 8.0.0. Therefore, if the reporting schema customizations
included additional campaign attributes, do the following:
a. Use your database management tools to determine the value from each
attribute's AttributeID column in the UA_CampAttribute table.
b. In IBM EMM, select Settings > Configuration and expand Reports >
Schemas > Campaign > Campaign Custom Attributes > Columns >
Campaign.
c. Delete the existing custom campaign attributes that were added for this
installation, but do not delete the standard custom campaign attributes. (The
standard custom campaign attributes were upgraded by the installer.)
d. Re-create the attributes you deleted. Enter the ID of the attribute in the
Attribute ID field.
7. Follow the steps in the procedure named “Step: Generate the view or table
creation scripts” on page 50 to generate the new versions of the scripts.
8. Use the procedures in the section “Step: Create the reporting views or tables”
on page 51 to create the new versions of the reporting views or tables.
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Generate updated SQL scripts for the reporting views or tables
This procedure describes how to generate updated SQL scripts for existing
reporting views or tables. If you are configuring views or tables for the first time,
do not use this procedure. Instead, see the IBM Marketing Platform Installation
Guide.
To generate updated SQL scripts, complete the following steps:
1. Select Settings > Reports SQL Generator. The SQL Generator page appears.
2. In the Product field, select the appropriate IBM application.
3. In the Schema field, select one or more reporting schemas. Use the table in
“SQL scripts by data source” to determine the appropriate schemas to select.
4. Select the Database Type. This option must match the database type of the
database for which you are generating the script.
5. In the Generate Type field, select the appropriate option (views, materialized
views, or tables).
Materialized views are not an option when Database Type is set to MS SQL
Server.
If the JNDI data source names are incorrect or have not been configured, the
SQL Generator cannot generate scripts that create tables.
6. Set the value in the Generate Drop Statement field to Yes.
7. (Optional.) To examine the SQL, click Generate. The SQL Generator creates
the script and displays it in the browser window.
8. Click Download.
The SQL Generator creates the script and prompts you to specify where you
want to save the file. If you selected a single reporting schema from the
Schema field, the script name matches the name of schema
(eMessage_Mailing_Execution.sql, for example). If you selected more than one
reporting schema, the script name uses the product name only (Campaign.sql,
for example). For a complete list of names, see “SQL scripts by data source.”
9. Specify the location where you want to save the script. If you change the
name of the file, be sure to use something that clearly indicates which
schemas you selected. Then click Save.
10. Repeat steps 7 through 10 but select No in the Drop Statement field this time.
11. Repeat steps 3 through 11 for each script you want to generate.
Note: There might be times when you want to disable script validation. For
example, perhaps the Marketing Platform cannot connect to the IBM
application database but you want to generate the scripts anyway. To disable
validation, clear the values in the data source configuration properties for
reporting. When you generate the scripts, the Reports SQL Generator displays
a warning that it cannot connect to the data source, but it still generates the
SQL script.
SQL scripts by data source: The following table shows which scripts you need to
generate for each data source, the resulting script names and, for creating views or
materialized views, which script should be run against which IBM application
database. Note the following.
v
The table lists the default names for the data sources and the generated scripts,
which you might have changed.
v
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The Interact reporting schemas reference more than one data source. Generate a
separate SQL script for each data source.
Reporting schema

Data source (default names)

Script name (default names)

All Campaign reporting schemas

Campaign system tables

Campaign.sql, unless you generated
separate scripts for each reporting
schema. If you did, each script is
named after the individual schema.

(campaignPartition1DS)

eMessage Mailing Performance

eMessage tracking tables, which are
with the Campaign system tables

eMessage_Mailing_ Performance.sql

(campaignPartition1DS)
Interact Deployment History, Interact
Performance, and Interact Views

Interact design time database

Interact Learning

Interact Learning tables

Interact.sql

(campaignPartition1DS)
Interact_Learning.sql

(InteractLearningDS)
Interact Run Time

Interact run time database

Interact_Runtime.sql

(InteractRTDS)

Update the views or reporting tables
Note that this procedure describes updating existing views or reporting tables. If
you are creating views or reporting tables for the first time, do not use this
procedure. Instead, use the reports chapter in the installation guide for your IBM
application.
After you generate and download the SQL scripts that update your views or
tables, run them on the application databases.
1. Locate the SQL scripts that you generated and saved. Use the table in “SQL
scripts by data source” on page 74 to determine which scripts to run against
which database.
2. Use your database administration tools to run the drop scripts.
3. Use your database administration tools to run the creation scripts.
4. For reporting tables, use your database administration tools to populate the
new tables with the appropriate data from the production system database.
5. For reporting tables and materialized views, use your database administration
tools to schedule data synchronization processes between the IBM application's
production databases and the new reporting tables or materialized views to run
regularly.
Note: You must use your own tools for this step. The Reports SQL Generator
does not generate this SQL for you.

Step: Obtain the JDBC driver for the Marketing Platform
system tables
Obtain the JDBC drivers and any required associated files that you used to
configure the JDBC data source for the Marketing Platform's system tables when
you set up the IBM EMM system. In a task later in this chapter, you configure
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Cognos to use IBM EMM authentication. Cognos needs the JDBC driver so it can
obtain user information from the Marketing Platform system tables when it uses
IBM EMM authentication.
Copy the JDBC driver to the machine where the Cognos Content Manager is
installed, to the webapps\p2pd\WEB-INF\AAA\lib directory under your Cognos
installation.

Step: Run the installers and upgrade the IBM integration
components
If yours is a distributed Cognos installation, determine which machine is running
the Cognos Content manager.
1. Stop the IBM Cognos service.
2. On the IBM Cognos BI system that runs the Cognos Content Manager,
download or copy the following IBM installers to a single directory:
v IBM
v Marketing Platform
v IBM application report package(s)
3. Run the IBM installer. (It will launch the sub-installers for the Marketing
Platform and the report package in order.)
4. In the first Products window, ensure that both the Marketing Platform and the
report package options are selected.
5. In the Platform Database Connection window, provide the necessary
information about how to connect to the Marketing Platform system tables.
6. When the installer asks whether you want to upgrade Affinium Manager,
specify No.
7. When the Platform Installation Components window appears, select the
Reports for IBM Cognos option and clear the other options
8. When the Marketing Platform installer prompts for the path to the JDBC
driver, enter the fully qualified path for the JDBC driver you copied to the
Cognos system during the task “Step: Obtain the JDBC driver for the
Marketing Platform system tables” on page 58.
9. When the Marketing Platform installer prompts for the location of the IBM
Cognos installation, enter or browse to the top level of the IBM Cognos
installation directory. Note that the default value provided in this field is a
static value that is not based on the actual file structure of your IBM Cognos
system.
10. When the report package installer takes over and displays its installation
options, select the IBM Cognos package for IBM [product] option and clear
the option for the reporting schemas. This installation option copies the
reports archive to the Cognos machine. You import this archive manually later.
11. When the installers are finished, copy the JDBC driver for the Marketing
Platform database to the IBM Cognos webapps\p2pd\WEB-INF\AAA\lib
directory. Be sure to copy the driver. Do not cut and paste the driver.
12. Restart the IBM Cognos server.

Step: Upgrade the 7.5.1 model and install the new reports
The version 8.x report packages include new and changed reports as well as
Dashboard reports for most of the IBM EMM applications. Although the model can
be upgraded, your 7.5.1 reports cannot. Instead you must install the new 8.x
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reports and then either recreate the reporting customizations you made to the 7.5.1
versions or copy the old reports back into the folder.
1. Verify that you backed up the model and the old reports.
2. Navigate to the ProductNameReportsPack\CognosN directory under your IBM
EMM product installation.
The N in the path refers to the Cognos version number.
3. Copy the reports archive .zip file (for example IBM EMM Reports for
Campaign.zip) to the directory where your Cognos deployment archives are
saved.
The default location is the deployment directory under your IBM EMM
Cognos installation and it is specified in the Cognos Configuration tool
installed with the Cognos Content Manager.
For example: cognosN\deployment.
The N in the path refers to the Cognos version number.
In a distributed IBM Cognos environment, this is a location on the system
running the Content Manager.
4. Only if you did not install your IBM EMM product to the default directory
(C:\Unica on Windows) you must update some upgrade scripts as described
in this step.
You must update the following scripts.
v

preUpgrade_86_fromanyversion.xml
Required only for Campaign and Interact.
v upgrade751to80.xml
v upgrade80to81.xml
v
v

upgrade81to85.xml
upgrade85to86.xml

The scripts are all located in the ProductNameReportsPack\cognosN\
ProductNameModel directory under your IBM EMM product installation.
The N in the path refers to the Cognos version number.
In each script, edit file paths that point to directories where localized language
versions of the models are stored to reflect your product install location. Make
this change for every language your users need. For example:
install_directory \ReportsPackCampaign\cognosN\CampaignModel\
translations\L\translations.txt
The N in the path refers to the Cognos version number.
The L in the path refers to one of the following language indicators.
v fr
v de
v es
v it
v ja
v ko
v pt
v zh
5. Open Cognos Connection.
6. Select Administer Cognos Content > Configuration > Content
Administration.
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7. Click the New Import button on the toolbar
folder.
8. Open Cognos Framework Manager.
9. Select Project > Run Script.
10. Run the following scripts.
v upgrade751to80.xml
v upgrade80to81.xml
v upgrade81to85.xml

and import the reports

v upgrade85to86.xml
The scripts are all located in the ProductNameReportsPack\cognosN\
ProductNameModel directory under your IBM EMM product installation.
The N in the path refers to the Cognos version number.
11. Publish the package to the Cognos content store.
12. Run a report to ensure that it works properly.
13. If the 7.5.1 reports were customized, recreate those customizations.
Alternately, if you can ensure that an old report will work properly with the
upgraded model, copy the old report back.
For information about fixing the old Campaign Performance by Cell reports
and the old Offer Performance Summary by Campaign reports so they work
with the new data model, continue with the remaining procedures in this
section.
14. If you have reports installed for multiple partitions, configure a reports
packages for the additional partitions using the instructions in the chapter that
describes how to configure multiple partitions.
15. Optional. See “Configure IBM Cognos to use IBM EMM authentication” on
page 64 for information about the new authentication mode, "authenticate per
user."

Step: Updating the old Campaign Performance by Cell reports
After you upgrade the Campaign model from 7.5.1 to 8.x, the old Campaign
Performance by Cell reports do not function properly. If you want to use your old
Campaign Performance by Cell reports rather than the new ones, you must
manually update them yourself.

How to fix the cross-object Performance by Cell reports
Use this procedure to fix the old versions of the following cross-object reports so
they function with the new data model.
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
v Campaign Performance Summary by Cell by Initiative
Complete the following steps.
1. Open the report in IBM Cognos Report Studio.
2. Click the lock icon on the toolbar to unlock the report.
3. Browse to the Query Explorer and open the Report Query for a list of all the
query items in the report.
4. For all three reports, remap the following query items as follows:
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Query item

Mapping

Number of Offers Given

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Number of Offers Given]

Response Transactions

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Response Transactions]

Unique Recipients

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Unique Recipients]

Unique Responders

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders]

Unique Recipients Control [Campaign Performance Summary].[Campaign Cell CH with
Group
Controls Summary].[Unique Recipients Control Group]
Unique Responders
Control Group

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders Control Group]

5. For the report with revenue, remap for the Gross Revenue item as follows:
[Campaign Performance Summary].[Campaign Cell RH with Controls
Summary].[Gross Revenue]
6. Update the formula for the Responder Rate Control Group to be the
following:
IF(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)) is missing)
THEN (0)
ELSE(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)))

7. From the Detail Filter list, select the first detail filter and edit it so it looks
like this:
[Campaign Performance Summary] . [Campaign] . [Campaign ID] in
(?CampaignIds?)
8. From the Detail Filter list, delete the second detail filter – the one that looks
like this:
[Campaign Performance Summary].[Responder Rate Control Group at Cell
Level].[Campaign ID] in (?CampaignIds?)
9. Lock the report.
10. Do the following in Report Studio for each report.
a. Go to File > Report Package.
b. Select "IBM Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response
window.
11. Save and run the report.

How to fix the object-specific Performance by Cell reports
Use this procedure to fix the old versions of the following object specific reports to
function with the new data model.
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
Complete the following steps.
1. Open the report in IBM Cognos Report Studio.
2. Click the lock icon on the toolbar to unlock the report.
Chapter 9. Upgrading reports

79

3. Browse to the Query Explorer and open the Report Query for a list of all the
query items in the report.
4. For both reports, remap the following query items as follows:
Query item

Mapping

Number of Offers Given

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Number of Offers Given]

Response Transactions

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Response Transactions

Unique Recipients

[Campaign Performance Summary].[Campaign Cell CH with
Controls Summary].[Unique Recipients]

Unique Responders

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders]

Unique Recipients Control [Campaign Performance Summary].[Campaign Cell CH with
Group
Controls Summary].[Unique Recipients Control Group]
Unique Responders
Control Group

[Campaign Performance Summary].[Campaign Cell RH with
Controls Summary].[Unique Responders Control Group]

5. For the report with revenue, remap the Gross Revenue query item as follows:
[Campaign Performance Summary].[Campaign Cell RH with Controls
Summary].[Gross Revenue]
6. Update the formula for the Responder Rate Control Group to be the
following:
IF(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)) is missing)
THEN (0)
ELSE(([Unique Responders Control Group]/([Unique Recipients Control Group]
* 1.00)))

7. From the Detail Filter list, select the first detail filter and edit it so it looks
like this:
[Campaign Performance Summary].[Campaign].[Campaign ID] in
(?CampaignIds?)
8. Delete the second detail filter – the one that looks like this:
[Campaign Performance Summary].[Responder Rate Control Group at Cell
Level].[Campaign ID] in (?CampaignIds?)
9. Lock the report.
10. Do the following in Report Studio for each report.
a. Go to File > Report Package.
b. Select "IBM Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response
window.
11. Save and run the report.

Step: Updating the old Offer Performance Summary by
Campaign reports
After upgrading the Campaign model from 7.5.1 to 8.x, the old Offer Performance
Summary by Campaign reports do not function properly. If you want to use your
old Offer Performance Summary by Campaign reports rather than the new ones,
you must update them manually.
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How to fix the Offer Performance Summary by Campaign
cross-object report
Use this procedure to fix the old version of the cross-object Offer Performance
Summary by Campaign report so it functions with the new data model.
1. Open the report in IBM Cognos Report Studio.
2. Browse to the Query Explorer and open the Report Query for a list of all the
query items in the report.
3. Configure the aggregation as follows for the following Campaign Level
Counts query items:
Query item

Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given

None

Automatic

Response Transactions

None

Automatic

Unique Recipients

None

Automatic

Unique Responders

None

Automatic

Not Contacted Responders

None

Automatic

Responses after Expiration

None

Automatic

Unique Recipients Control Group

None

Automatic

Unique Responders Control Group

None

Automatic

4. Configure the aggregation as follows for the following Campaign Level
Counts query items:
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Rate

Automatic

Automatic

Responder Rate

Automatic

Automatic

Responder Rate Control Group

Automatic

Automatic

Best Offer Lift Over This

Automatic

Automatic

Lift Over Worst Offer

Automatic

Automatic

Lift Over Control Group

Automatic

Automatic

5. Configure the aggregation as follows for the following Offer Level Counts
query items:
Query item

Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given-Offer

None

Automatic

Unique Responders-Offer

None

Automatic

Not Contacted Responders-Offer

None

Automatic

Responses after Expiration-Offer

None

Automatic

Unique Responders Control Group-Offer

None

Automatic

6. Change the expression for the Response Transactions-Offer query item to be
the following:
[Offer Performance Summary].[Offer Response History Summary].
[Response Transactions] / count([Campaign Name] for [Offer ID])
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7. Configure the aggregation as follows for the following Offer Level Counts
query items:
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Transactions - Offer

Total

Automatic

Unique Recipients - Offer

Total

Automatic

Unique Recipients Control Group - Offer

Total

Automatic

8. Configure the aggregation as follows for the following Offer Level Counts
query items:
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Rate - Offer

Automatic

Automatic

Responder Rate - Offer

Automatic

Automatic

Responder Rate Control Group - Offer

Automatic

Automatic

Lift Over Control Group - Offer

Automatic

Automatic

9. For the Report Total level counts, change the expression for Total Response
Transactions to be:
total ([Response Transactions-Offer])
10. Also for Total Response Transactions, confirm that Aggregate Function is set
to Automatic and that Rollup Aggregate Function is set to Automatic.
11. Lock the report.
12. Do the following in Report Studio for each report.
a. Go to File > Report Package
b. Select "IBM Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response
window.
13. Save and run the report.

How to fix the single object Offer Performance Summary by
Campaign report
Use this procedure to fix the old version of the single object Offer Performance
Summary by Campaign report so it functions with the new data model.
1. Open the report in IBM Cognos Report Studio.
2. Browse to the Query Explorer and open the Report Query for a list of all the
query items in the report.
3. Configure the aggregation as follows for the following Campaign Level
Counts query items:

82

Query item

Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given

None

Automatic

Response Transactions

None

Automatic

Unique Recipients

None

Automatic

Unique Responders

None

Automatic
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Query item

Aggregate
Function

Rollup Aggregate
Function

Not Contacted Responders

None

Automatic

Responses after Expiration

None

Automatic

Unique Recipients Control Group

None

Automatic

Unique Responders Control Group

None

Automatic

4. Configure the aggregation as follows for the following Campaign Level
Counts query items:
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Rate

Automatic

Automatic

Responder Rate

Automatic

Automatic

Responder Rate Control Group

Automatic

Automatic

Best Offer Lift Over This

Automatic

Automatic

Lift Over Worst Offer

Automatic

Automatic

Lift Over Control Group

Automatic

Automatic

5. Configure the aggregation as follows for the following Offer Level Counts
query items:
Query item

Aggregate
Function

Rollup Aggregate
Function

Number of Offers Given-Offer

None

Automatic

Unique Responders-Offer

None

Automatic

Not Contacted Responders-Offer

None

Automatic

Responses after Expiration-Offer

None

Automatic

Unique Responders Control Group-Offer

None

Automatic

6. Change the expression for the Response Transactions-Offer query item to be
the following:
[Offer Performance Summary].[Offer Response History Summary].
[Response Transactions] / count([Campaign Name] for [Offer ID])

7. Configure the aggregation as follows for the following Offer Level Counts
query items:
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Transactions - Offer

Total

Automatic

Unique Recipients - Offer

Total

Automatic

Unique Recipients Control Group - Offer

Total

Automatic

8. Configure the aggregation as follows for the following Offer Level Counts
query items:
Query item

Aggregate
Function

Rollup Aggregate
Function

Response Rate - Offer

Automatic

Automatic
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Query item

Aggregate
Function

Rollup Aggregate
Function

Responder Rate - Offer

Automatic

Automatic

Responder Rate Control Group - Offer

Automatic

Automatic

Lift Over Control Group - Offer

Automatic

Automatic

9. Lock the report.
10. Do the following in Report Studio for each report.
a. Go to File > Report Package
b. Select "IBM Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response
window.
11. Save and run the report.

Upgrading reports from version 8.x
Follow the steps in this section if you are upgrading an IBM EMM application
from version 8.x.

Step: Upgrade the 8.x model and install the new reports
1. Navigate to the ProductNameReportsPack\CognosN directory under your IBM
product installation.
The N in the path refers to the Cognos version number.
2. Copy the reports archive .zip file (for example IBM EMM Reports for
Campaign.zip) to the directory where your Cognos deployment archives are
saved.
The default location is the deployment directory under your Cognos
installation and it is specified in the Cognos Configuration tool installed with
the Cognos Content Manager. For example: cognos\deployment
In a distributed Cognos environment, this is a location on the system running
the Content Manager.
3. Only if you did not install your IBM product to the default directory
(C:\Unica on Windows) you must update some upgrade scripts as described
in this step.
You must update the following scripts.
v preUpgrade_86_fromanyversion.xml
Required only for Campaign and Interact.
v upgrade80to81.xml
v upgrade81to85.xml
v upgrade85to86.xml
The scripts are all located in the ProductNameReportsPack\cognosN\
ProductNameModel directory under your IBM product installation.
The N in the path refers to the Cognos version number.
In each script, edit file paths that point to directories where localized language
versions of the models are stored to reflect your product install location. Make
this change for every language your users need. For example:
install_directory \ReportsPackCampaign\cognosN\CampaignModel\
translations\L\translations.txt
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The N in the path refers to the Cognos version number.
The L in the path refers to one of the following language indicators.
v fr
v de
v es
v it
v ja
v ko
v pt
v zh
4. Open Cognos Connection.
5. Select Administer Cognos Content > Configuration > Content
Administration.
6. Click the New Import button on the toolbar
folder.

and import the reports

7. Open Cognos Framework Manager.
8. Select Project > Run Script.
9. Run the following scripts.
v upgrade80to81.xml
v upgrade81to85.xml
v upgrade85to86.xml
The scripts are all located in the ProductNameReportsPack\cognosN\
ProductNameModel directory under your IBM product installation.
The N in the path refers to the Cognos version number.
10. Publish the package to the Cognos content store.
11. Do the following in Cognos Report Studio for each cross-object Performance
by Cell and object-specific Performance by Cell report.
a. Go to File > Report Package.
b. Select "IBM Campaign Package" and click OK.
c. Fill in prompts on the report as necessary.
d. After the report is validated, click Close in the Validation Response
window.

Chapter 9. Upgrading reports
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Appendix A. About Marketing Platform utilities
This section provides an overview of the Marketing Platform utilities, including
some details that apply to all of the utilities and which are not included in the
individual utility descriptions.

Location of utilities
Marketing Platform utilities are located in the tools/bin directory under your
Marketing Platform installation.

List and descriptions of utilities
The Marketing Platform provides the following utilities.
v “The configTool utility” on page 89 - imports, exports, and deletes configuration
settings, including product registrations
v “The datafilteringScriptTool utility” on page 93 - creates data filters
v “The encryptPasswords utility” on page 94 - encrypts and stores passwords
v “The partitionTool utility” on page 95 - creates database entries for partitions
v “The populateDb utility” on page 97 - populates the Marketing Platform
database
v “The restoreAccess utility” on page 98 - restores a user with the
platformAdminRole role
v “The scheduler_console_client utility” on page 100 - lists or kicks off IBM
Scheduler jobs configured to listen for a trigger

Prerequisites for running Marketing Platform utilities
The following are prerequisites for running all Marketing Platform utilities.
v Run all utilities from the directory where they are located (by default, the
tools/bin directory under your Marketing Platform installation).
v On UNIX, the best practice is to run the utilities with the same user account that
runs the application server on which Marketing Platform is deployed. If you run
a utility with a different user account, adjust the permissions on the
platform.log file to allow that user account to write to it. If you do not adjust
permissions, the utility is not able to write to the log file and you might see
some error messages, although the tool should still function correctly.

Troubleshooting connection issues
If a Marketing Platform utility fails to complete its task successfully, you can use
the following information to help you resolve the issue.
v All of the Marketing Platform utilities except encryptPasswords interact with the
Marketing Platform system tables. To connect to the system table database, these
utilities use the following connection information, which is set by the installer
using information provided when the Marketing Platform was installed.
–
–
–
–
© IBM Corporation 1999, 2012

JDBC driver name
JDBC connection URL (which includes the host, port, and database name)
Data source login
Data source password (encrypted)
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This information is stored in the jdbc.properties file, located in the tools/bin
directory under your Marketing Platform installation. Check the values in this
file to ensure they are correct for your environment.
v In addition, Marketing Platform utilities rely on the JAVA_HOME environment
variable, set either in the setenv script located in the tools/bin directory of your
Marketing Platform installation, or on the command line.
The Marketing Platform installer should have set this variable automatically in
the setenv script, but it is a good practice to verify that the JAVA_HOME variable is
set if you have a problem running a utility. The JDK must be the Sun version
(not, for example, the JRockit JDK available with WebLogic).
Wherever it is set, the JAVA_HOME environment variable must point to the 1.6
version of the Sun JRE.
If your JAVA_HOME environment variable points to an incorrect JRE, then you
must unset the JAVA_HOME variable before you run the IBM installers. You can do
this as follows.
– Windows: In a command window, enter
set JAVA_HOME=leave empty and press return key
– *NIX-type systems: In the terminal, enter
export JAVA_HOME=leave empty and press return key
Do this before you invoke the Marketing Platform utility you want to run.

Special characters
Characters that are designated as reserved characters in the operating system must
be escaped. Consult your operating system documentation for a list of reserved
characters and how to escape them.

Standard options in Marketing Platform utilities
The following options are available in all Marketing Platform utilities.
-l logLevel
Set the level of log information displayed in the console. Options are high, medium,
and low. The default is low.
-L
Set the locale for console messages. The default locale is en_US. The available
option values are determined by the languages into which the Marketing Platform
has been translated. Specify the locale using the ICU locale ID according to ISO
639-1 and ISO 3166.
-h
Display a brief usage message in the console.
-m
Display the manual page for this utility in the console.
-v
Display more execution details in the console.
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Running Marketing Platform utilities on additional machines
On the machine where the Marketing Platform is installed, you can run the
Marketing Platform utilities without any additional configuration. However, you
might want to run the utilities from another machine on the network. This
procedure describes the steps required to do this.

To set up Marketing Platform utilities on additional machines
1. Ensure that the machine on which you perform this procedure meets the
following prerequisites.
v The correct JDBC driver must exist on the machine or be accessible from it.
v The machine must have network access to the Marketing Platform system
tables.
v The Java runtime environment must be installed on the machine or be
accessible from it.
2. Gather the following information about the Marketing Platform system tables.
v The fully qualified path for the JDBC driver file or files on your system.
v The fully qualified path to an installation of the Java runtime environment.
The default value in the installer is the path to the JRE that the installer
places under your IBM installation directory. You can accept this default or
specify a different path.
v Database type
v
v
v
v
v

Database
Database
Database
Database
Database

host
port
name/system ID
user name
password

3. Run the IBM installer and install the Marketing Platform.
Enter the database connection information that you gathered for the Marketing
Platform system tables. If you are not familiar with the IBM installer, see the
Campaign or Marketing Operations installation guide.
You do not have to deploy the Marketing Platform web application.

Reference: Marketing Platform utilities
This section describes the Marketing Platform utilities, with functional details,
syntax, and examples.

The configTool utility
The properties and values on the Configuration page are stored in the Marketing
Platform system tables. The configTool utility imports and exports configuration
settings to and from the Marketing Platform system tables.

When to use configTool
You might want to use configTool for the following reasons.
v To import partition and data source templates supplied with Campaign, which
you can then modify and duplicate using the Configuration page.
v To register (import configuration properties for) IBM EMM products, if the
product installer is unable to add the properties to the database automatically.
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v To export an XML version of configuration settings for backup or to import into
a different installation of IBM EMM.
v To delete categories that do not have the Delete Category link. You do this by
using configTool to export your configuration, then manually deleting the XML
that creates the category, and using configTool to import the edited XML.
Important: This utility modifies the usm_configuration and
usm_configuration_values tables in the Marketing Platform system table database,
which contain the configuration properties and their values. For best results, either
create backup copies of these tables, or export your existing configurations using
configTool and back up the resulting file so you have a way to restore your
configuration if you make an error when using configTool to import.

Valid product names
The configTool utility uses product names as parameters with the commands that
register and unregister products, as described later in this section. With the 8.0.0
release of IBM EMM, many product names changed. However, the names
recognized by configTool did not change. The valid product names for use with
configTool are listed below, along with the current names of the products.
Product name

Name used in configTool

Marketing Platform

Manager

Campaign

Campaign

Distributed Marketing

Collaborate

eMessage

emessage

Interact

interact

Contact Optimization

Optimize

Marketing Operations

Plan

CustomerInsight

Insight

Digital Analytics for On Premises

NetInsight

PredictiveInsight

Model

Leads

Leads

Syntax
configTool -d -p "elementPath" [-o]
configTool -i -p "parent ElementPath" -f importFile [-o]
configTool -x -p "elementPath" -f exportFile
configTool -r productName -f registrationFile [-o]
configTool -u productName

Commands
-d -p "elementPath"
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Delete configuration properties and their settings, specifying a path in the
configuration property hierarchy.
The element path must use the internal names of categories and properties, which
you can obtain by going to the Configuration page, selecting the wanted category
or property, and looking at the path displayed in parentheses in the right pane.
Delimit a path in the configuration property hierarchy using the | character, and
surround the path with double quotation marks.
Note the following.
v Only categories and properties within an application may be deleted using this
command, not whole applications. Use the -u command to unregister a whole
application.
v To delete categories that do not have the Delete Category link on the
Configuration page, use the -o option.
-i -p "parentElementPath" -f importFile
Import configuration properties and their settings from a specified XML file.
To import, you specify a path to the parent element under which you want to
import your categories. The configTool utility imports properties under the
category you specify in the path.
You can add categories at any level below the top level, but you cannot add a
category at same level as the top category.
The parent element path must use the internal names of categories and properties,
which you can obtain by going to the Configuration page, selecting the desired
category or property, and looking at the path displayed in parentheses in the right
pane. Delimit a path in the configuration property hierarchy using the | character,
and surround the path with double quotation marks.
You can specify an import file location relative to the tools/bin directory or you
can specify a full directory path. If you specify a relative path or no path,
configTool first looks for the file relative to the tools/bin directory.
By default, this command does not overwrite an existing category, but you can use
the -o option to force an overwrite.
-x -p "elementPath" -f exportFile
Export configuration properties and their settings to an XML file with a specified
name.
You can export all configuration properties or limit the export to a specific category
by specifying a path in the configuration property hierarchy.
The element path must use the internal names of categories and properties, which
you can obtain by going to the Configuration page, selecting the wanted category
or property, and looking at the path displayed in parentheses in the right pane.
Delimit a path in the configuration property hierarchy using the | character, and
surround the path with double quotation marks.
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You can specify an export file location relative to the current directory or you can
specify a full directory path. If the file specification does not contain a separator (/
on Unix, / or \ on Windows), configTool writes the file to the tools/bin directory
under your Marketing Platform installation. If you do not provide the xml
extension, configTool adds it.
-r productName -f registrationFile
Register the application. The registration file location may be relative to the
tools/bin directory or may be a full path. By default, this command does not
overwrite an existing configuration, but you can use the -o option to force an
overwrite. The productName parameter must be one of those listed above.
Note the following.
v When you use the -r option, the registration file must have <application> as
the first tag in the XML.
Other files may be provided with your product that you can use to insert
configuration properties into the Marketing Platform database. For these files,
use the -i option. Only the file that has the <application> tag as the first tag
can be used with the -r option.
v The registration file for the Marketing Platform is named Manager_config.xml,
and the first tag is <Suite>. To register this file on a new installation, use the
populateDb utility, or rerun the Marketing Platform installer as described in the
IBM Marketing Platform Installation Guide.
v After the initial installation, to reregister products other than the Marketing
Platform, use configTool with the -r option and -o to overwrite the existing
properties.
-u productName
Unregister an application specified by productName . You do not have to include a
path to the product category; the product name is sufficient. The productName
parameter must be one of those listed above. This removes all properties and
configuration settings for the product.

Options
-o
When used with -i or -r, overwrites an existing category or product registration
(node).
When used with -d allows you to delete a category (node) that does not have the
Delete Category link on the Configuration page.

Examples
v Import configuration settings from a file named Product_config.xml located in
the conf directory under the Marketing Platform installation.
configTool -i -p "Affinium" -f Product_config.xml
v Import one of the supplied Campaign data source templates into the default
Campaign partition, partition1. The example assumes that you placed the Oracle
data source template, OracleTemplate.xml, in the tools/bin directory under the
Marketing Platform installation.
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configTool -i -p "Affinium|Campaign|partitions|partition1|dataSources" -f
OracleTemplate.xml
v Export all configuration settings to a file named myConfig.xml located in the
D:\backups directory.
configTool -x -f D:\backups\myConfig.xml
v Export an existing Campaign partition (complete with data source entries), save
it to a file named partitionTemplate.xml, and store it in the default tools/bin
directory under the Marketing Platform installation.
configTool -x -p "Affinium|Campaign|partitions|partition1" -f
partitionTemplate.xml
v Manually register an application named productName, using a file named
app_config.xml located in the default tools/bin directory under the Marketing
Platform installation, and force it to overwrite an existing registration of this
application.
configTool -r product Name -f app_config.xml -o
v Unregister an application named productName.
configTool -u productName

The datafilteringScriptTool utility
The datafilteringScriptTool utility reads an XML file to populate the data
filtering tables in the Marketing Platform system table database.
Depending on how you write the XML, you can use this utility in two ways.
v Using one set of XML elements, you can auto-generate data filters based on
unique combinations of field values (one data filter for each unique
combination).
v Using a slightly different set of XML elements, you can specify each data filter
that the utility creates.
See IBM Marketing Platform the Administrator's Guide for information about creating
the XML.

When to use datafilteringScriptTool
You must use datafilteringScriptTool when you create new data filters.

Prerequisites
The Marketing Platform must be deployed and running.

Using datafilteringScriptTool with SSL
When the Marketing Platform is deployed using one-way SSL you must modify
the datafilteringScriptTool script to add the SSL options that perform handshaking.
To modify the script, you must have the following information.
v Truststore file name and path
v Truststore password
In a text editor, open the datafilteringScriptTool script (.bat or .sh) and find the
lines that look like this (examples are Windows version).
:callexec
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"%JAVA_HOME%\bin\java" -DUNICA_PLATFORM_HOME="%UNICA_PLATFORM_HOME%"
com.unica.management.client.datafiltering.tool.DataFilteringScriptTool %*
Edit these lines to look like this (new text is in bold). Substitute your truststore
path and file name and truststore password for myTrustStore.jks and myPassword.
:callexec
SET SSL_OPTIONS=-Djavax.net.ssl.keyStoreType="JKS"
-Djavax.net.ssl.trustStore="C:\security\myTrustStore.jks"
-Djavax.net.ssl.trustStorePassword=myPassword
"%JAVA_HOME%\bin\java" -DUNICA_PLATFORM_HOME="%UNICA_PLATFORM_HOME%"
%SSL_OPTIONS%
com.unica.management.client.datafiltering.tool.DataFilteringScriptTool %*

Syntax
datafilteringScriptTool -r pathfile

Commands
-r path_file
Import data filter specifications from a specified XML file. If the file is not located
in the tools/bin directory under your installation, provide a path and enclose the
path_file parameter in double quotation marks.

Example
v Use a file named collaborateDataFilters.xml, located in the C:\unica\xml
directory, to populate the data filter system tables.
datafilteringScriptTool -r "C:\unica\xml\collaborateDataFilters.xml"

The encryptPasswords utility
The encryptPasswords utility is used to encrypt and store either of two passwords
that the Marketing Platform uses, as follows.
v The password that the Marketing Platform uses to access its system tables. The
utility replaces an existing encrypted password (stored in the jdbc,properties
file, located in the tools\bin directory under your Marketing Platform
installation) with a new one.
v The keystore password used by the Marketing Platform when it is configured to
use SSL with a certificate other than the default one supplied with the Marketing
Platform or the web application server. The certificate can be either a self-signed
certificate or a certificate from a certificate authority.

When to use encryptPasswords
Use encryptPasswords as for the following reasons.
v When you change the password of the account used to access your Marketing
Platform system table database.
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v When you have created a self-signed certificate or have obtained one from a
certificate authority.

Prerequisites
v Before running encryptPasswords to encrypt and store a new database password,
make a backup copy of the jdbc.properties file, located in the tools/bin
directory under your Marketing Platform installation.
v Before running encryptPasswords to encrypt and store the keystore password,
you must have created or obtained a digital certificate and know the keystore
password.
See Appendix A, “About Marketing Platform utilities,” on page 87 for additional
prerequisites.

Syntax
encryptPasswords -d databasePassword
encryptPasswords -k keystorePassword

Commands
-d databasePassword
Encrypt the database password.
-k keystorePassword
Encrypt the keystore password and store it in a file named pfile.

Examples
v When the Marketing Platformwas installed, the login for the system table
database account was set to myLogin. Now, some time after installation, you have
changed the password for this account to newPassword. Run encryptPasswords as
follows to encrypt and store the database password.
encryptPasswords -d newPassword
v You are configuring an IBM EMM application to use SSL and have created or
obtained a digital certificate. Run encryptPasswords as follows to encrypt and
store the keystore password.
encryptPasswords -k myPassword

The partitionTool utility
Partitions are associated with Campaign policies and roles. These policies and roles
and their partition associations are stored in the Marketing Platform system tables.
The partitionTool utility seeds the Marketing Platform system tables with basic
policy and role information for partitions.

When to use partitionTool
For each partition you create, you must use partitionTool to seed the Marketing
Platform system tables with basic policy and role information.
See the installation guide appropriate for your version of Campaign for detailed
instructions on setting up multiple partitions in Campaign.
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Special characters and spaces
Any partition description or user, group, or partition name that contains spaces
must be enclosed in double quotation marks.
See Appendix A, “About Marketing Platform utilities,” on page 87 for additional
restrictions.

Syntax
partitionTool -c -s sourcePartition -n newPartitionName [-u
admin_user_name] [-d partitionDescription] [-g groupName]

Commands
The following commands are available in the partitionTool utility.
-c
Replicates (clones) the policies and roles for an existing partition specified using
the -s option, and uses the name specified using the -n option. Both of these
options are required with c. This command does the following.
v Creates a new IBM EMM user with the Admin role in both the Administrative
Roles policy and the global policy in Campaign. The partition name you specify
is automatically set as this user’s password.
v Creates a new Marketing Platform group and makes the new Admin user a
member of that group.
v Creates a new partition object.
v Replicates all the policies associated with the source partition and associates
them with the new partition.
v For each replicated policy, replicates all roles associated with the policy.
v For each replicated role, maps all functions in the same way that they were
mapped in the source role.
v Assigns the new Marketing Platform group to the last system-defined Admin
role created during role replication. If you are cloning the default partition,
partition1, this role is the default Administrative Role (Admin).

Options
-d partitionDescription
Optional, used with -c only. Specifies a description that appears in the output from
the -list command. Must be 256 characters or less. Enclose in double quotation
marks if the description contains spaces.
-g groupName
Optional, used with -c only. Specifies the name of the Marketing Platform Admin
group that the utility creates. The name must be unique within this instance of the
Marketing Platform
If not defined, the name defaults to partition_nameAdminGroup.
-n partitionName
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Optional with -list, required with -c. Must be 32 characters or less.
When used with -list, specifies the partition whose information is listed.
When used with -c, specifies the name of the new partition, and the partition
name you specify is used as the password for the Admin user. The partition name
must match the name you gave the partition in when you configured it (using the
partition template on the Configuration page).
-s sourcePartition
Required, used with -c only. The name of the source partition to be replicated.
-u adminUserName
Optional, used with -c only. Specifies the user name of the Admin user for the
replicated partition. The name must be unique within this instance of the
Marketing Platform.
If not defined, the name defaults to partitionNameAdminUser.
The partition name is automatically set as this user’s password.

Examples
v Create a partition with the following characteristics.
– Cloned from partition1
– Partition name is myPartition
– Uses the default user name (myPartitionAdminUser) and password
(myPartition)
– Uses the default group name (myPartitionAdminGroup)
– Description is “ClonedFromPartition1”
partitionTool -c -s partition1 -n myPartition -d "ClonedFromPartition1"
v Create a partition with the following characteristics.
– Cloned from partition1
– Partition name is partition2
– Specifies user name of customerA with the automatically assigned password of
partition2
– Specifies group name of customerAGroup
– Description is “PartitionForCustomerAGroup”
partitionTool -c -s partition1 -n partition2 -u customerA -g
customerAGroup -d "PartitionForCustomerAGroup"

The populateDb utility
The populateDb utility inserts default (seed) data in the Marketing Platform system
tables.
The IBM installer can populate the Marketing Platform system tables with default
data for the Marketing Platform and for Campaign. However, if your company
policy does not permit the installer to change the database, or if the installer is
unable to connect with the Marketing Platform system tables, you must insert
default data in the Marketing Platform system tables using this utility.
Appendix A. About Marketing Platform utilities

97

For Campaign, this data includes security roles and permissions for the default
partition. For the Marketing Platform, this data includes default users and groups,
and security roles and permissions for the default partition.

Syntax
populateDb -n productName

Commands
-n productName
Insert default data into the Marketing Platform system tables. Valid product names
are Manager (for the Marketing Platform) and Campaign (for Campaign).

Examples
v
Insert Marketing Platform default data manually.
populateDb -n Manager
v
Insert Campaign default data manually.
populateDb -n Campaign

The restoreAccess utility
The restoreAccess utility allows you to restore access to the Marketing Platform if
all users with PlatformAdminRole privileges have been inadvertently locked out or
if all ability to log in to the Marketing Platform has been lost.

When to use restoreAccess
You might want to use restoreAccess under the two circumstances described in
this section.
PlatformAdminRole users disabled
It is possible that all users with PlatformAdminRole privileges in the Marketing
Platformmight become disabled in the system. Here is an example of how the
platform_admin user account might become disabled. Suppose you have only one
user with PlatformAdminRole privileges (the platform_admin user). Assume the
Maximum failed login attempts allowed property property in the General |
Password settings category on the Configuration page is set to 3. Then suppose
someone who is attempting to log in as platform_admin enters an incorrect
password three times in a row. These failed login attempts cause the
platform_admin account to become disabled in the system.
In that case, you can use restoreAccess to add a user with PlatformAdminRole
privileges to the Marketing Platform system tables without accessing the web
interface.
When you run restoreAccess in this way, the utility creates a user with the login
name and password you specify, and with PlatformAdminRole privileges.
If the user login name you specify exists in the Marketing Platform as an internal
user, that user’s password is changed.
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Only a user with the login name of PlatformAdmin and with PlatformAdminRole
privileges can universally administer all dashboards. So if the platform_admin user
is disabled and you create a user with restoreAccess, you should create a user
with a login of platform_admin.
Improper configuration of Active Directory integration
If you implement Windows Active Directory integration with improper
configuration and can no longer log in, use restoreAccess to restore the ability to
log in.
When you run restoreAccess in this way, the utility changes the value of the
Platform | Security | Login method property from Windows integrated login to
Marketing Platform. This change allows you to log in with any user account that
existed before you were locked out. You can optionally specify a new login name
and password as well. You must restart the web application server on which the
Marketing Platform is deployed if you use the restoreAccess utility in this way.

Password considerations
Note the following about passwords when you use restoreAccess.
v The restoreAccess utility does not support blank passwords, and does not
enforce password rules.
v If you specify a user name that is in use, the utility resets the password for that
user.

Syntax
restoreAccess -u loginName -p password
restoreAccess -r

Commands
-r
When used without the -u loginName option, reset the value of the Unica |
Security | Login method property to Marketing Platform. Requires restart of the
web application server to take effect.
When used with the -u loginName option, create a PlatformAdminRole user.

Options
-u loginNname
Create a user with PlatformAdminRole privileges with the specified login name.
Must be used with the -p option.
-p password
Specify the password for the user being created. Required with -u.
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Examples
v Create a user with PlatformAdminRole privileges. The login name is tempUser
and the password is tempPassword.
restoreAccess -u tempUser -p tempPassword
v Change the value of the login method to Unica Marketing Platform and create a
user with PlatformAdminRole privileges. The login name is tempUser and the
password is tempPassword.
restoreAccess -r -u tempUser -p tempPassword

The scheduler_console_client utility
Jobs configured in the IBM EMM Scheduler can be listed and kicked off by this
utility, if they are set up to listen for a trigger.

What to do if SSL is enabled
When the Marketing Platform web application is configured to use SSL, the JVM
used by the scheduler_console_client utility must use the same SSL certificate
that is used by the web application server on which the Marketing Platform is
deployed.
Take the following steps to import the SSL certificate
v Determine the location of the JRE used by the scheduler_console_client.
– If JAVA_HOME is set as a system environment variable, the JRE it points to is
the one used by the scheduler_console_client utility.
– If JAVA_HOME is not set as a system environment variable, the
scheduler_console_client utility uses the JRE set either in the setenv script
located in the tools/bin directory of your Marketing Platform installation, or
on the command line.
v Import the SSL certificate used by the web application server on which the
Marketing Platform is deployed to the JRE used by scheduler_console_client.
The Sun JDK includes a program called keytool that you can use to import the
certificate. Consult the Java documentation for complete details on using this
program, or access the help by entering -help when you run the program.
If the certificates do not match, the Marketing Platform log file contains an error
such as the following.
Caused by: sun.security.provider.certpath.SunCertPathBuilderException:
unable to find valid certification path to requested target

Prerequisites
The Marketing Platform must be installed, deployed, and running.

Syntax
scheduler_console_client -v -t trigger_name user_name
scheduler_console_client -s -t trigger_name user_name
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Commands
-v
List the Scheduler jobs configured to listen for the specified trigger.
Must be used with the -t option.
-s
Execute the Scheduler jobs configured to listen for the specified trigger.
Must be used with the -t option.

Options
-t trigger_name
The name of the trigger, as configured in the Scheduler.

Example
v List jobs configured to listen for a trigger named trigger1.
scheduler_console_client -v -t trigger1
v Execute jobs configured to listen for a trigger named trigger1.
scheduler_console_client -s -t trigger1

About Marketing Platform SQL scripts
This section describes the SQL scripts provided with the Marketing Platform to
perform various tasks relating to the Marketing Platform system tables. They are
designed to be run against the Marketing Platform system tables.
The Marketing Platform SQL scripts are located in the db directory under your
Marketing Platform installation.
You must use the database client to run the SQL against the Marketing Platform
system tables.

Reference: Marketing Platform SQL scripts
This section describes the Marketing Platform SQL scripts.

Removing all data (ManagerSchema_DeleteAll.sql)
The Manager_Schema_DeleteAll.sql script removes all data from the Marketing
Platform system tables without removing the tables themselves. This script
removes all users, groups, security credentials, data filters, and configuration
settings from the Marketing Platform.

When to use ManagerSchema_DeleteAll.sql
You might want to use ManagerSchema_DeleteAll.sql if corrupted data prevents
you from using an instance of the Marketing Platform.
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Additional requirements
To make the Marketing Platform operational after running
ManagerSchema_DeleteAll.sql , you must perform the following steps.
v Run the populateDB utility as described in “The populateDb utility” on page 97.
The populateDB utility restores the default configuration properties, users, roles,
and groups, but does not restore any users, roles, and groups you have created
or imported after initial installation.
v Use the configTool utility with the config_navigation.xml file to import menu
items, as described in “The configTool utility” on page 89.
v If you have performed any post-installation configuration, such as creating data
filters or integrating with an LDAP server or web access control platform, you
must perform these configurations again.
v If you want to restore previously existing data filters, run the
datafilteringScriptTool utility using the XML originally created to specify the
data filters.

Removing data filters only
(ManagerSchema_PurgeDataFiltering.sql)
The ManagerSchema_PurgeDataFiltering.sql script removes all data filtering data
from the Marketing Platform system tables without removing the data filter tables
themselves. This script removes all data filters, data filter configurations,
audiences, and data filter assignments from the Marketing Platform.

When to use ManagerSchema_PurgeDataFiltering.sql
You might want to use ManagerSchema_PurgeDataFiltering.sql if you need to
remove all data filters without removing other data in the Marketing Platform
system tables.
Important: The ManagerSchema_PurgeDataFiltering.sql script does not reset the
values of the two data filter properties, Default table name and Default audience
name. If these values are no longer valid for the data filters you want to use, you
must set the values manually on the Configuration page.

Removing system tables (ManagerSchema_DropAll.sql)
The ManagerSchema_DropAll.sql script removes all Marketing Platform system
tables from a database. This script removes all tables, users, groups, security
credentials, and configuration settings from the Marketing Platform.
Note: If you run this script against a database containing an earlier version of the
Marketing Platform system tables, you might receive error messages in your
database client stating that constraints do not exist. Youcan safely ignore these
messages.

When to use ManagerSchema_DropAll.sql
You might want to use ManagerSchema_DropAll.sql if you have uninstalled an
instance of the Marketing Platform where the system tables are in a database that
contains other tables you want to continue using.
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Additional requirements
To make the Marketing Platform operational after running this script, you must
perform the following steps.
v Run the appropriate SQL script to re-create the system tables, as described in
“Creating system tables.”
v Run the populateDB utility as described in “The populateDb utility” on page 97.
Running the populateDB utility restores the default configuration properties,
users, roles, and groups, but does not restore any users, roles, and groups you
have created or imported after initial installation.
v Use the configTool utility with the config_navigation.xml file to import menu
items, as described in “The configTool utility” on page 89.
v If you have performed any post-installation configuration, such as creating data
filters or integrating with an LDAP server or web access control platform, you
must perform these configurations again.

Creating system tables
Use the scripts described in the following table to create Marketing Platform
system tables manually, when your company policy does not allow you to use the
installer to create them automatically. The scripts are shown in the order in which
you must run them.
Datasource Type
IBM DB2

Microsoft SQL Server

Oracle

Script Names
v

ManagerSchema_DB2.sql
If you plan to support multi-byte characters (for example,
Chinese, Japanese, or Korean), use the
ManagerSchema_DB2_unicode.sql script.

v

ManagerSchema__DB2_CeateFKConstraints.sql

v

active_portlets.sql

v

ManagerSchema_SqlServer.sql

v

ManagerSchema__SqlServer_CeateFKConstraints.sql

v

active_portlets.sql

v

ManagerSchema_Oracle.sql

v

ManagerSchema__Oracle_CeateFKConstraints.sql

v

active_portlets.sql

If you plan to use the Scheduler feature that enables you to configure a flowchart
to run at predefined intervals, you must also create the tables that support this
feature. To create the Scheduler tables, run the appropriate script, as described in
the following table.
Data Source Type

Script Name

IBM DB2

quartz_db2.sql

Microsoft SQL Server

quartz_sqlServer.sql

Oracle

quartz_oracle.sql
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When to use the create system tables scripts
You must use these scripts when you install or upgrade the Marketing Platform if
you have not allowed the installer to create the system tables automatically, or if
you have used ManagerSchema_DropAll.sql to delete all Marketing Platform system
tables from your database.
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Appendix B. Uninstalling IBM products
You might need to uninstall an IBM product if you are doing the following.
v Retiring a system.
v Removing an IBM product from your system.
v Freeing up space on a system.
When you install IBM EMM products, an uninstaller is included in the
Uninstall_Product directory, where Product is the name of your IBM product. On
Windows, an entry is also added to the Add or Remove Programs list in the
Control Panel.
Running the IBM uninstaller ensures that all configuration files, installer registry
information, and user data are removed from the system. If you manually remove
the files in your installation directory instead of running the uninstaller, the result
might be an incomplete installation if you later reinstall an IBM product in the
same location. After uninstalling a product, its database is not removed. The
uninstaller only removes default files that get created during installation. Any file
created or generated after installation is not removed.

To uninstall IBM products
Follow these instructions to properly remove IBM products from your system.
Note: On UNIX, the same user account that installed IBM EMM must run the
uninstaller.
1. Undeploy the IBM EMM product web application from WebSphere or
WebLogic.
2. Shut down WebSphere or WebLogic.
3. Stop any running processes that are related to the product you are uninstalling.
For example, stopping the Campaign or Contact Optimization Listener services
before uninstalling those products.
4. Run the IBM EMM uninstaller and follow the directions in the wizard.
The uninstaller is located in the Uninstall_Product directory, where Product is
the name of your IBM EMM product.
When you uninstall a product that was installed using unattended mode, the
uninstall is performed in unattended mode (without presenting any dialogs for
user interaction).

© IBM Corporation 1999, 2012
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Contacting IBM technical support
If you encounter a problem that you cannot resolve by consulting the
documentation, your company’s designated support contact can log a call with
IBM technical support. Use the information in this section to ensure that your
problem is resolved efficiently and successfully.
If you are not a designated support contact at your company, contact your IBM
administrator for information.

Information to gather
Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain
as described in "System information."

System information
When you call IBM technical support, you might be asked to provide information
about your environment.
If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.
You can access the About page by selecting Help > About. If the About page is not
accessible, you can obtain the version number of any IBM application by viewing
the version.txt file located under the installation directory for each application.

Contact information for IBM technical support
For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.unica.com/about/product-technical-support.htm).

© Copyright IBM Corp. 1999, 2012
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Notices
This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.
For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan
The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.
This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.
Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.
The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.
Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.
All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.
All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.
COPYRIGHT LICENSE:
This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.
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